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ABSTRAKT
Práce se zabývá inovací cvičení z oblasti zpracování obrazu. Inovace spočívá v připra-
vení návodů jednotlivých cvičení v alternativních programech, ve výuce se nyní používá
program Adobe Photoshop CS6 Extended. První kapitola se zabývá barevnými modely,
prostory, správou barev a formáty bitmapové grafiky. Ve druhé kapitole jsou předsta-
veny alternativní bitmapové editory – Adobe Photoshop CC 2021, GIMP, Affinity Photo,
Zoner Photo Studio X, Corel PaintShop Pro 2022. Následně jsou porovnány podle ně-
kolika kritérií, je zvážena cenová náročnost pro školu i studenta a je proveden výběr
programů vhodných pro výuku zpracování obrazu. V dalších kapitolách jsou vypraco-
vány návody jednotlivých cvičení ve vybraných programech a je provedeno zhodnocení
vhodnosti těchto programů pro výuku.

KLÍČOVÁ SLOVA
bitmapa, grafický editor, návod, počítačová grafika, zpracování obrazu

ABSTRACT
The bachelor thesis deals with innovation of lectures in the field of image processing.
The innovation consists in the preparation of instructions for individual exercises in
alternative programs, Adobe Photoshop CS6 Extended is now used in exercises. The
first chapter deals with color models, spaces, color management and bitmap file formats.
The second chapter introduces alternative bitmap editors – Adobe Photoshop CC 2021,
GIMP, Affinity Photo, Zoner Photo Studio X, Corel PaintShop Pro 2022. Then they are
compared according to several criteria, the cost for the school and students is considered
and a selection of programs suitable for teaching image processing is made. In the
next chapters, instructions for individual exercises are made in selected programs and
an evaluation of the suitability of these programs for teaching is performed.
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Úvod
Tato práce se zabývá zpracováním obrazu, bitmapové grafice. Cílem práce je sezná-
mit se s obsahem výuky předmětu Základy počítačové sazby a grafiky a inovovat
cvičení, ve kterých se nyní používá program Adobe Photoshop CS6 Extended. Ino-
vace cvičení spočívá v připravení návodů pro jednotlivá cvičení v alternativních
programech pro zpracování obrazu.

V první kapitole práce je rozebrána teorie, která se zabývá bitmapovou grafikou.
V první části teorie jsou popsány barevné modely a barevné prostory používané
ve cvičení a je popsána správa barev. V druhé části teorie jsou popsány formáty
bitmapové grafiky, které se používají ve cvičení.

V druhé kapitole jsou vybrány a představeny alternativní programy pro zpraco-
vání obrazu – Adobe Photoshop CC 2021, GIMP, Affinity Photo, Zoner Photo Stu-
dio X, Corel PaintShop Pro 2022 a je provedeno porovnání jednotlivých programů.
Porovnání je provedeno z hlediska požadavků na hardware, podporovaných ope-
račních systémů, podporovaných formátů, podporovaných barevných režimů, pod-
porovaných funkcí používaných ve cvičení. Je zvážena cenová náročnost pro školu
i pro studenta. Porovnání je shrnuto a jsou vybrány programy vhodné pro jednotlivá
cvičení výuky zpracování obrazu.

V dalších kapitolách jsou vypracovány návody pro jednotlivá počítačová cvičení
ve vybraných programech a je provedeno zhodnocení vhodnosti těchto programů
pro výuku, včetně zvážení faktoru cenové zátěže pro školu i pro studenta. Je vy-
brán alternativní program k nyní používanému programu Adobe Photoshop CS6
Extended.
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1 Bitmapová grafika
Počítače zpracovávají a ukládají grafická data dvěma způsoby, vektorovou nebo
bitmapovou grafikou [1].

V bitmapové grafice je obraz rozdělen do mřížky s pixely. Jednotlivé pixely mají
svoji souřadnici a barvu, která je popsaná pomocí některého barevného modelu [2].
Znázornění bitmapy je na obr. 1.1.

Bitmapový obraz je definovaný rozlišením a barevnou hloubkou, výsledná kvalita
obrazu je ovlivněna těmito parametry. Rozlišení obrazu se většinou udává v ppi, ppi
udává počet pixelů, kterých je obsaženo v řádku o délce jednoho palce. Barevná
hloubka definuje počet bitů, které byly použity k popisu barvy jednoho pixelu.

Výhodou bitmapové grafiky je snadné pořízení obrazu, např. fotoaparátem nebo
skenerem. Nevýhodou bitmapové grafiky je výpočetní náročnost, velikost zpraco-
vaných dat [3]. Změnou velikosti obrazu dojde ke zhoršení kvality, při zvětšování
bitmapy dojde ke zvýšené viditelnosti jednotlivých pixelů.

Obr. 1.1: Znázornění bitmapy.

1.1 Barevný model, barevný prostor

Barevný model je matematická struktura popisující barvu [4]. Předpokládá se, že je
barva reprezentovaná číselnou hodnotou. Nejčastěji je barevný model popsán uspo-
řádanou trojicí nebo čtveřicí hodnot barevných složek.

Barevný model může používat aditivní nebo subtraktivní míchání barev [5]. Ba-
revný model/prostor může být závislý nebo nezávislý na zařízení. Model závislý na
zařízení zobrazí barvu na několika zařízeních různě, např. RGB. Prostor nezávislý
na konkrétním zařízení, má vizuální charakteristiku barvy stejnou při reprodukci na
všech zařízeních, např. Lab.
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Barevný prostor je založen na barevném modelu, ke kterému je přidán popis,
jak interpretovat barevné složky [4]. V barevném prostoru jsou obsaženy standar-
dizované odstíny základních barev [6]. S barevným prostorem se nejčastěji setkáme
u zařízení, jako jsou např. tiskárny, monitory, skenery. Barevné prostory založené
na barevném modelu RGB jsou např. sRGB, Adobe RGB, Apple RGB, Pro Photo
RGB.

Gamut je rozsah barev, které je barevný prostor schopný zobrazit [7]. Barvy
mimo tento prostor je schopen zobrazit přibližně po přepočtu, metody přepočtu jsou:
perceptuální, sytostní, relativní kolorimetrická a absolutní kolorimetrická. Porovnání
gamutů několika barevných prostorů je znázorněno na obr. 1.2.

Obr. 1.2: Znázornění gamutu několika barevných prostorů v řezu prostorem
CIEXYZ. Obr. převzat z [8].

1.1.1 RGB, RGBA

Vlastností modelu RGB je aditivní míchání barev. K zobrazení různých barev se
používá součtová kombinace základních tří složek – červené (R, red), zelené (G,
green), modré (B, blue). Složky se přidávají do základní černé barvy, čím více složek
barvy přidáme, tím bude výsledná barva světlejší [3], viz obr. 1.3.

Jedná se o barevný model, který je založen na principu vyzařování světla. Používá
se pro popis barev u zobrazovacích zařízení, jako jsou např. monitory, projektory.
Tento model je závislý na konkrétním zařízení [4].

Model RGBA je založen na modelu RGB, ale je rozšířen o 8bitový alfa kanál, ve
kterém je informace o průhlednosti [9].
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Obr. 1.3: Míchání barev v modelu RGB.

1.1.2 CMY, CMYK

Vlastností modelu CMY je subtraktivní míchání barev, používá se typicky v tiskové
technice, je závislý na konktrétním zařízení [3]. K zobrazení různých barev se používá
subtraktivní kombinace základních tří složek – azurové (C, cyan), purpurové (M,
magenta), žluté (Y, yellow) [4]. Složky se odečítají od základní bílé barvy, čím více
složek barvy přidáme, tím bude výsledná barva tmavší, viz obr. 1.4.

Model CMYK je založen na modelu CMY, který je rozšířen o složku klíčovou,
černou (K, black). Smíchání tří barev C, M, Y při tisku nezaručí přesně černou
barvu a z hlediska ekonomického je výhodnější použití samostatné černé barvy [10].
Tento barevný model se používá u reprodukčních zařízení, jako je např. inkoustová
tiskárna.

Obr. 1.4: Míchání barev v modelu CMY.

1.1.3 HSB

Model HSB nejvíce odpovídá způsobu, jak lidské oko vnímá barvy [4]. Tento model
se skládá ze tří složek – hue (H, odstín), saturation (S, sytost), brightness (B, jas).
Znázornění modelu odpovídá rotačnímu kuželi [3], viz obr. 1.5. Model HSB bývá
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někdy označen jako HSV, složka brightness se změní na value, která také označuje
jasovou složku [11].

Hodnota odstínu se mění s rotací kolem středu podstavy. Hodnota sytosti před-
stavuje vzdálenost od středu podstavy ke straně pláště. Hodnota jasu představuje
vzdálenost od podstavy k vrcholu kužele.

Obr. 1.5: Znázornění modelu HSV rotačním kuželem. Obr. převzat z [11].

1.1.4 CIEXYZ

Barevný prostor CIEXYZ využívá vlastnosti lidského oka, které je více citlivé na jas,
než na barvu. Vychází z modelu RGB, je nezávislý na zařízení a zobrazuje všechny
lidským okem viditelné barvy [4].

CIEXYZ odděluje jasovou složku Y od složek barvonosných, které jsou označeny
x a y. Parametry x a y mohou být vypočteny ze složek X, Y a Z. Dvojrozměrné
zobrazení řezu CIE xyY se nazývá chromatický diagram [12], viz obr. 1.2.

1.1.5 L*a*b

Barevný prostor L*a*b, označovaný také Lab nebo CIELAB, je nezávislý na kon-
krétním zařízení [13]. Prostor L*a*b obsahuje celé viditelné spektrum barev, má
větší gamut než modely RGB a CMYK [4]. Skládá se ze tří složek – světlost (L,
lightness), barva z rozsahu zelené až červené, barva z rozsahu modré až žluté [3], viz
obr. 1.6.

V prostoru L*a*b můžeme při zpracování obrazu provádět odděleně úpravy ba-
rev a jasu. Při úpravě jasu upravujeme pouze jasovou složku, bez ovlivnění složek
barvonosných, toho se využívá např. při doostření obrazu [14].
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Obr. 1.6: Barevný prostor Lab při světlosti L = 50 %.

1.1.6 YCbCr

Model YCbCr se používá při zpracování rastrového obrazu, zpracování videa nebo
digitální fotografie [15]. Formát JPEG využívá tento barevný model. Skládá se ze tří
složek – Y (jasová), Cb (modrá barvonosná složka), Cr (červená barvonosná složka).

Oddělení jasové a barvonosné složky je důležité pro zachování vzájemné kompa-
tibility barevného televizního vysílání s černobílým televizorem [4]. Oddělení složek
má také význam pro vlastnost lidského oka, které je více citlivé na jas, než na barvu.
Jasový signál může mít větší šířku pásma, větší rozlišení, než dvě barvonosné složky,
které mohou být více komprimované, redukované [3]. Ukázka převodu fotografie do
modelu YCbCr je na obr. 1.7.

Obr. 1.7: Převod fotografie do modelu YCbCr.
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1.1.7 Stupně šedi

Jedná se o jednorozměrný model, obsahuje monochromatické odstíny barev od černé
po bílou [16]. Tyto barvy se nacházejí u modelů RGB a CMYK na úsečce mezi
W a K v jednotkové krychli [4], viz obr. 1.8. U modelu HSB se nacházejí na úsečce
jasu (B), u modelu L*a*b ve složce světlosti (L), u modelu YCbCr a CIEXYZ ve
složce jasu (Y).

Obr. 1.8: Jednotková krychle modelů RGB a CMYK.

1.1.8 Správa barev

Každé zařízení, ať už se jedná např. o monitor, skener, tiskárnu má jiné možnosti
interpretace barev, můžeme mu přiřadit barevný profil ICC. Tento profil popisuje
vlastnosti a barevný gamut zařízení [7]. Správa barev porovnává profily vstupních
a výstupních zařízení a v případě neshody profilů provede úpravy, tak aby byly
barvy na různých zařízeních co nejvíce podobné [17].

V případě neshody profilů zařízení se musí barvy přepočítat podle určitých pra-
videl. Používají se čtyři metody pro přepočet: perceptuální, sytostní, relativní kolo-
rimetrická a absolutní kolorimetrická [4].

Perceptuální metoda se využívá převážně u fotografií, kde je velké množství ba-
rev mimo rámec gamutu. Snaží se zachovat vizuální vztahy mezi barvami, výsledkem
je pro lidské oko příjemné podání barev. Sytostní metoda se využívá u grafů a logo-
typů, odstín barvy je méně důležitý, než sytost. U relativní kolorimetrické metody
se přemění barvy mimo rámec vstupního gamutu na nejbližší barvy výstupního
gamutu, vstupní gamut se ořízne. Umožňuje přizpůsobení barev podle vstupního
a výstupního bílého bodu [18]. Absolutní kolorimetrická metoda je podobná rela-
tivní kolorimetrické metodě, ale neumožňuje přizpůsobení barev podle vstupního
a výstupního bílého bodu. Metody přepočtu jsou znázorněny na obr. 1.9.
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Obr. 1.9: Znázornění metod přepočtu gamutu. Obr. převzat z [19].

1.2 Formáty bitmapové grafiky
Formát souboru udává pravidla, podle kterých se bitmapa ukládá do souboru [20].
Z hlediska komprese existují dva druhy formátů – bezeztrátové a ztrátové. Mezi
nejpoužívanější formáty bitmapové grafiky patří BMP, GIF, JPEG, PNG [3].

Bezeztrátová komprese je založena na algoritmech, které umožní bezeztrátovou
zpětnou rekonstrukci komprimovaných dat. Formáty BMP, PNG, RAW patří mezi
bezeztrátové [21].

Ztrátová komprese je založena na algoritmech, které umožní zmenšit objem dat
redukcí redundance a irelevance. Data se při kompresi ztratí a nemůžou být zpětně
rekonstruována bezeztrátově. Ztrátová komprese je výhodná z hlediska velikosti dat,
ztráta nadbytečných dat nemusí mít výrazný vliv na kvalitu obrazu. Formát JPEG
je ztrátový [22].

Některé formáty používají pro uložení a zobrazení bitmapy barevnou paletu.
Barevná paleta obsahuje určitý počet barev podle bitové hloubky bitmapy. Barva
v paletě má přidělené číslo a každý pixel má hodnotu čísla barvy, na kterou odkazuje
do palety. Výhodou barevné palety je malá velikost souboru [23].

1.2.1 BMP

BMP je formát souboru určený pro ukládání bitmapové grafiky. BMP může být
použito v několika barevných hloubkách – 1 bpp, 4 bpp, 8 bpp, 24 bpp [4]. BMP
využívá barevnou paletu.

Tento formát většinou nepoužívá žádnou kompresi dat. Výhodou tohoto formátu
je jednoduchost, není patentovaný – rozšířen v grafických editorech a operačních
systémech [24]. Do tohoto formátu je vhodné ukládat např. ikony, tlačítka.
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1.2.2 GIF

GIF je formát souboru využívaný pro ukládání bitmapy s barevnou paletou, umož-
ňuje i jednoduchou animaci. GIF používá bezeztrátovou kompresní metodu LZW.
Maximální barevná hloubka je 8 bpp, maximální počet barev je 256 v jednom ob-
rázku [25].

GIF se využívá pro uložení jednoduchých animací a pro uložení bitmapové grafiky
s malým počtem barev, u které je potřeba zachovat bezeztrátovost – loga, grafy,
webová grafika [3].

1.2.3 JPEG

JPEG je nejrozšířenější a nejpoužívanější formát souboru určený pro ukládání bitma-
pové grafiky [26]. Využívá se nejčastěji pro ukládání fotografií, používá ztrátovou
kompresi a má poměrně malou velikost. Může používat progresivní kódování, které
umožňuje zobrazení náhledu obrazu, před jeho úplným načtením.

Nevýhodou je omezená barevná hloubka na 24 bpp, absence alfa kanálu. Není
vhodný pro ukládání bitmap s malým počtem barev, jako jsou např. grafy, loga,
kompresní algoritmus vytváří v obrazu rušivé artefakty.

Postup kódování JPEG:
1. Transformace barev z výchozího barevného modelu do modelu YCbCr umožní

zpracovat zvlášť barvonosnou a jasovou složku [27].
2. Podvzorkování barvonosných složek Cb a Cr umožní zmenšení objemu dat.

Využívá se vlastnosti lidského oka, které je více citlivé na jas, než na barvu.
3. Rozdělení složek obrazu do bloků 8×8 px, aplikace diskrétní kosinové transfor-

mace (DCT). Výsledkem DCT je 8×8 reálných koeficientů [4].
4. Výsledek DCT je kvantován kvantizační maticí a zaokrouhlen. Mnoho hodnot

je nulových, dojde ke ztrátě informace a snížení bitové rychlosti.
5. Vyčítání dat metodou zig-zag, kódování metodou RLE a následně Huffmano-

vým nebo aritmetickým kódováním.
6. Uložení dat do souboru.

1.2.4 JPEG 2000

JPEG 2000 je nástupcem formátu JPEG a používá se převážně pro ukládání fo-
tografií. Nepracuje na principu rozložení obrazu do bloků, ale na rozkladu celého
obrazu vlnkovou transformací [4]. Má progresivní charakter, který umožňuje zobra-
zení náhledu obrazu, před jeho úplným načtením [28].

Výhodou tohoto formátu ve srovnání s formátem JPEG jsou: lepší komprese,
podpora obrázků s vysokým dynamickým rozsahem, větší barevná hloubka, použití
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alfa kanálu, podpora modelů např. RGB, stupňů šedi, CMYK. Umožňuje ztráto-
vou i neztrátovou kompresi, umožňuje ROI. ROI neboli oblast zájmu je určitá část
obrazu, u které lze nastavit vyšší rozlišení, prioritní načtení, využívá se např. u ka-
merových systémů, rentgenových snímků.

Nevýhodou tohoto formátu je vyšší výpočetní náročnost, malá rozšířitelnost a ne-
musí být podporovaný některými editory bitmapové grafiky [29].

1.2.5 PNG

PNG je formát souboru pro bezeztrátovou kompresi bitmapové grafiky [30]. Používá
bezeztrátové kódování na principu slovníkového algoritmu LZ77 . Umožňuje ukládat
obraz s průhledným pozadím, alfa kanálem [3].

PNG8 využívá barevné palety s barevnou hloubkou 8 bpp, až 256 barev v pa-
letě [31]. Je vhodný pro ukládání obrazu, kde se nevyskytuje velké množství barev,
např. snímek obrazovky, desky plošných spojů.

PNG24 může ukládat obraz s podporou barevné hloubky 24 bpp [4]. Je vhodný
pro obraz s velkým počtem barev, může být použit místo formátu JPEG pro ukládání
fotografií, ale není komprimovaný.

Porovnáme-li formáty PNG a GIF, GIF využívá komprese LZW, PNG využívá
bezeztrátové kódování LZ77. GIF podporuje pouze barevnou paletu s maximální
barevnou hloubkou 8 bpp, PNG podporuje barevnou paletu s maximální barevnou
hloubkou 8 bpp, ale i režim truecolor s až 16 bity na kanál. PNG podporuje alfa
kanál, GIF podporuje použití jednoduchých animací, PNG obvykle dosahuje lepší
komprese [30].

1.2.6 RAW

RAW není souborový formát, ale jedná se o skupinu formátů se společným prin-
cipem. Jedná se o data zachycená snímačem, která nejsou zpracována do finálního
obrazu [32]. Nezpracovaná data umožňují lepší využití dynamického rozsahu a větší
možnosti bezeztrátových úprav než ostatní formáty. Mezi úpravy patří: korekce ex-
pozice, vyvážení bílé, úprava tónů barev a další [33]. Dynamický rozsah je u obrazu
poměr mezi místem s nejvyšším a nejnižším jasem [34].
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2 Programy pro úpravu bitmap
Ve výuce je nyní používaný program Adobe Photoshop CS6 Extended, jako alterna-
tiva k tomuto programu byly vybrány další často používané profesionální bitmapové
editory, které podporují funkce používané ve cvičení výuky zpracování obrazu. K po-
rovnání byly vybrány další bitmapové editory – Adobe Photoshop CC 2021, GIMP,
Affinity Photo, Zoner Photo Studio X, Corel PaintShop Pro 2022.

2.1 Adobe Photoshop

Adobe Photoshop je profesionální program, který patří do skupiny 2D bitmapo-
vých editorů [35]. Je vyvíjený firmou Adobe Inc. pro operační systémy Windows
a macOS. Tento program patří mezi nejlepší ve svém oboru. Umožňuje upravovat
bitmapovou grafiku ve vrstvách, pracovat v několika barevných modelech, jako jsou
RGB, CMYK, Lab, HSB. Adobe Photoshop dále podporuje práci s maskami, ba-
revnými kanály, možnosti instalace pluginů atd.

Adobe Photoshop používá pro bezeztrátové uchování grafických dat formát sou-
boru PSD [36]. Do tohoto výchozího formátu se ukládají např. vrstvy, filtry, masky,
rozlišení, barevné modely. Tento formát souboru může být načten a upravován v ji-
ných aplikacích než Adobe Photoshop [37].

Bratři Thomas a John Knoll vyvinuli původní verzi Photoshopu v roce 1987.

2.2 GIMP

GIMP je bitmapový grafický editor, který je vhodný pro úpravu fotografií a webové
grafiky [38]. Umožňuje také pracovat s vektorovou grafikou.

Můžeme pracovat s grafikou ve vrstvách, používat různé nástroje, pracovat s ba-
revnými kanály, používat filtry s barevnou hloubkou až 32 bitů na kanál.

Název GIMP je zkratkou slov GNU Image Manipulation Program [39]. Tento pro-
gram je otevřený, svobodný, kdokoliv může upravovat zdrojový kód, šířit program.
Výhodou GIMPu je snadná upravitelnost, rozšířitelnost s použitím pluginů, skriptů.
Další výhodou je, že není nutná instalace a vytvoření uživatelského účtu. Tento
program je podporovaný na operačních systémech Linux, BSD, macOS, Microsoft
Windows a Solaris.

GIMP používá pro bezeztrátové uchování grafických dat formát XCF, do kterého
jsou ukládána všechna data, která program zpracovává. Do souboru se ukládají
vrstvy, výběry, kanály, průhlednost, cesty a vodítka [40]. Informace jsou vztaženy
k verzi 2.10.
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Program GIMP začali vyvíjet v roce 1995 Spencer Kimball a Peter Mattis, pů-
vodně pro operační systém Linux. V roce 1997 se stal podporovaný i na operačních
systémech Microsoft Windows a macOS [41].

2.3 Affinity Photo

Affinity Photo je bitmapový grafický editor, který je vhodný především pro úpravu
fotografií. Program je vyvíjen britskou společností Serif, původně pro operační sys-
tém macOS. První beta verze tohoto programu byla vydaná v roce 2015 pro macOS,
v roce 2016 byla vydaná verze pro operační systém Microsoft Windows [42].

Podporuje PSD, prostředí pro úpravu formátu RAW, umožňuje upravovat bitma-
povou grafiku s barevnou hloubkou až 32 bpp. Podporované barevné modely jsou
RGB, CMYK, Lab, stupně šedi [43]. Informace jsou vztaženy k verzi programu
1.10.1.

2.4 Zoner Photo Studio X

Zoner Photo Studio X je bitmapový grafický editor, vhodný zejména pro úpravu
fotografií a správu souborů. Je vyvíjený brněnskou společností ZONER software,
pouze pro operační systém Windows [44].

Umožňuje pracovat s grafikou ve vrstvách, používat různé nástroje, používat
masky, histogram. Umožňuje zpracovat bitmapu ve formátu RAW [45], podporuje
barevnou hloubku až 48 bpp.

Zoner Photo Studio X používá pro bezeztrátové uchování grafických dat formát
ZPS, do kterého jsou ukládána všechna data, která program zpracovává. Do souboru
se ukládají např. vrstvy, masky, bitmapové soubory [46].

2.5 Corel PaintShop Pro 2022

Corel PaintShop Pro 2022 je grafický editor, který umožňuje zpracovávat bitma-
povou i vektorovou grafiku [47]. Program je vyvíjen společností Corel, první verze
tohoto programu byla vydaná v roce 1990 pro operační systém Microsoft Windows.
Umožňuje zpracovávat bitmapu v barevných modelech RGB, stupních šedi. V ba-
revném modelu RGB umožňuje pracovat s barevnou hloubkou až 48 bpp.

Corel PaintShop Pro 2022 používá pro bezeztrátové uchování grafických dat for-
mát PSP, do kterého jsou ukládána všechna data, která program zpracovává. Do
souboru se ukládají např. vrstvy, masky, bitmapové soubory.
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2.6 Porovnání programů
Bylo provedeno porovnání programů na základě několika kritérií: požadavky na
hardware, podporované operační systémy, podporované formáty, podporované ba-
revné režimy, podporované funkce, cena.

2.6.1 Požadavky na hardware a systém

Každý program má jiné minimální požadavky na hardware a systém. Bylo prove-
deno porovnání minimálních požadavků jednotlivých programů na procesor, ope-
rační systém, paměť RAM, paměť HDD, displej a grafickou kartu. Grafická karta je
spravována sadou knihoven, aplikačním rozhraním (API) – Metal [48], DirectX [49],
OpenGL [50].

Tab. 2.1: Srovnání minimálních požadavků na HW pro operační systém Microsoft
Windows.
Kompo-
nent

Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

Procesor Intel
Pentium
4 nebo
AMD
Athlon 64

Intel,
64bitová
archi-
tektura,
2 GHz

Intel
Pen-
tium 4,
2 GHz

Intel
Pentium
4

Intel nebo
AMD

Intel Cele-
ron G nebo
AMD Phe-
nom 2

Operační
systém

Windows
XP

Windows
10

Windows 7 Windows
XP

Windows 8 Windows
10

Paměť
RAM

1 GB 8 GB 2 GB 250 MB 4 GB 4 GB

Paměť
HDD

1 GB 4 GB 1 GB 1 GB 0.5 GB 3 GB

Displej 1 024×768 1 280×800 1 280×768 1 024×768 1 280×800 1 366×768
Grafická
karta

S podporou
OpenGL
2.0

S podporou
DirectX 12

S pod-
porou
DirectX
10

S pod-
porou
OpenGL
2.0

S pod-
porou
OpenGL
2.0

S pod-
porou
DirectX 10

Srovnáme-li požadavky na hardware pro operační systém Windows, tak je z tab. 2.1
patrné, že Adobe Photoshop CC 2021, Zoner Photo Studio X a Corel PaintShop Pro
2022 mají větší požadavky na hardware, než nyní ve výuce využívaný Adobe Pho-
toshop CS6 Extended. Adobe Photoshop CC 2021 podporuje pouze počítače s
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minimální velikostí RAM 8 GB, což může být pro některé počítače limitující. Nejmenší
požadavky na hardware má program GIMP.

V tab. 2.2 jsou porovnány požadavky na hardware pro operační systém macOS.
Největší požadavky na hardware má Adobe Photoshop CC 2021, nejmenší GIMP.

Tab. 2.2: Srovnání minimálních požadavků na HW pro operační systém macOS.

Kompo-
nent

Photoshop
CS6 Exten-
ded

Photoshop
CC 2021

Affinity
Photo

GIMP

Procesor Vícejádrový
procesor In-
tel, 64bitová
architektura

Intel 64bitová
architektura,
2 GHz

Apple M1 nebo
Intel

Intel Pentium 4

Operační
systém

Mac OS X
v10.6.8, ma-
cOS X Moun-
tain Lion v10.8

macOS Mojave macOS Cata-
lina

macOS Cata-
lina

Paměť RAM 1 GB 8 GB 2 GB 250 MB
Paměť HDD 2 GB 4 GB 3 GB 1 GB
Displej 1 024×768 1 280×800 1 280×768 1 024×768
Grafická
karta

S podporou
OpenGL 2.0

S podporou roz-
hraní Metal

S podporou roz-
hraní Metal

S podporou roz-
hraní Metal

Na počítače s operačním systémem Linux můžeme nainstalovat pouze program
GIMP. Požadavky na minimální hardware jsou pro operační systém Linux srovna-
telné jako pro operační systém Windows.

Bylo provedeno porovnání podpory operačních systémů jednotlivými programy,
viz tab. 2.3. Všechny programy podporují operační systém Windows. Operační sys-
tém macOS je podporován programy Adobe Photoshop CS6 Extended, Adobe Pho-
toshop CC 2021, Affinity Photo, GIMP. Operační systémy Linux, BSD, Solaris pod-
poruje pouze program GIMP.

Jako zdroje informací v této části textu byly použity [35], [39], [43], [47], [51],
[52], [53], [54], [55].

2.6.2 Podporované formáty

V tab. 2.4 je provedeno porovnání podpory ve výuce používaných formátů: BMP,
GIF, JPEG, JPEG 2000, PNG, TIFF.

Nevýhodou programů Affinity Photo, Zoner Photo Studio X je nemožnost ulo-
žení bitmapy do souboru ve formátu JPEG 2000 [55], je umožněno pouze otevření
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Tab. 2.3: Srovnání podporovaných operačních systémů.

Operační
systém

Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

Windows ano ano ano ano ano ano
macOS ano ano ano ano ne ne
Linux ne ne ne ano ne ne
BSD ne ne ne ano ne ne
Solaris ne ne ne ano ne ne

tohoto souboru. Affinity Photo neumožňuje uložení bitmapy do souboru ve formátu
BMP [56]. Program GIMP neumožňuje uložení bitmapy do souboru ve formátu
JPEG 2000, podpora uložení do tohoto formátu je řešena pluginem. Pouze programy
Adobe Photoshop CS6 Extended, Adobe Photoshop CC 2021 a Corel PaintShop Pro
2022 umožňují otevření i uložení bitmapy do souboru ve formátu JPEG 2000 [54].

Tab. 2.4: Srovnání podporovaných formátů.

Formát Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

BMP ano ano ano
(pouze
otevření)

ano ano ano

GIF ano ano ano ano ano ano
JPEG ano ano ano ano ano ano
JPEG
2000

plugin ano ano
(pouze
otevření)

plugin ano
(pouze
otevření)

ano

PNG ano ano ano ano ano ano
RAW ano ano ano plugin ano ano
TIFF ano ano ano ano ano ano

2.6.3 Podporované barevné modely a prostory

V tab. 2.5 je provedeno porovnání podpory barevných modelů. Adobe Photoshop
umožňuje zpracovávat obraz v barevných modelech CMYK, Lab, RGB, indexované
barvě a stupních šedi [16].

39



GIMP umožňuje upravovat obraz v barevných modelech RGB a stupních šedi [57].
Model CMYK je podporován pomocí dekompozice pluginem Separate. Možnosti
zpracování obrazu s tímto pluginem jsou však značně omezené, GIMP tedy není
vhodný program pro profesionální tiskovou úpravu bitmap.

Zoner Photo Studio X umožňuje upravovat obraz pouze v barevném modelu
RGB a stupních šedi, program podporuje ostatní barevné modely pouze při načtení
obrazu, poté se obraz převede do modelu RGB [58].

Affinity Photo umožňuje pracovat s obrazem v barevných režimech RGB, CMYK,
Lab a stupních šedi [59]. Corel PaintShop Pro umožňuje pracovat s obrazem v ba-
revných režimech RGB, stupních šedi a indexované barvě [60].

Tab. 2.5: Srovnání podporovaných barevných modelů a prostorů.

Barevný
model,
prostor

Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

CMYK ano ano ano plugin ne ne
Indexova-
ná barva

ano ano ne ano ne ano

Lab ano ano ano ne ne ne
RGB ano ano ano ano ano ano
Stupně
šedi

ano ano ano ano ano ano

2.6.4 Podpora grafického tabletu

V rámci výuky se používá grafický tablet Wacom Graphire 4 CTE-440. Ve výuce se
mimo jiné využívá vlastnosti tabletu, která umožní znázornění tloušťky čáry podle
přítlaku vyvinutého na hrot pera. Grafický tablet je podporován všemi programy
uvedenými v porovnání.

2.6.5 Podporované funkce

První počítačové cvičení

První počítačové cvičení se zabývá seznámením se s ovládáním programu, nasta-
vením správy barev. Používané funkce v rámci prvního počítačového cvičení jsou
např. vytvoření nového plátna, otevření souboru, uložení souboru, správa barev, ná-
hled tiskového výstupu, náhled kontroly gamutu. V tab. 2.6 je provedeno srovnání
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podpory funkcí používaných v rámci prvního počítačového cvičení jednotlivými pro-
gramy.

Tab. 2.6: Srovnání podporovaných funkcí používaných v 1. počítačovém cvičení.

Funkce Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

Nastavení
čtyř ba-
revných
přepočtů

ano ano ano ano ano ano

Náhled
kontroly
gamutu

ano ano ano ano ano ne

Náhled tis-
kového vý-
stupu

ano ano ano ano ano ne

Otevření
souboru

ano ano ano ano ano ano

Přepnutí
pracovních
prostorů

ano ano ano ano ano ano

Přepočtové
křivky
CMYK

ano ano ne ne ne ne

Správa ba-
rev

ano ano ano ano ano ano

Uložení
souboru

ano ano ano ano ano ano

Vytvoření
nového
plátna

ano ano ano ano ano ano

Druhé počítačové cvičení

Druhé počítačové cvičení se zabývá reprezentací obrazu v počítači. Používané funkce
v rámci druhého počítačového cvičení jsou např. prozkoumání barevných složek u ob-
rázku, filtr odstín a sytost, vrstvy, vrstvy úprav, převedení obrazu do stupňů šedi,
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nástroj úrovně, vyvážení bílé, maska vrstvy, kanály, kapátko, výběr barvy z pa-
lety. V tab. 2.7 je provedeno srovnání podpory funkcí používaných v rámci druhého
počítačového cvičení jednotlivými programy.

Tab. 2.7: Srovnání podporovaných funkcí používaných ve 2. počítačovém cvičení.

Funkce Photoshop

CS6 Exten-

ded

Photoshop

CC 2021

Affinity

Photo

GIMP Zoner

Photo

Studio X

Corel Pa-

intShop

Pro 2022

Barevný
model stupně
šedi

ano ano ano ano ano ano

Barevný pro-
stor LAB

ano ano ano rozložení
obrázku
do složek
nástrojem
Dekompo-
novat

ne ne

Černá a bílá
filtr

ano ano ano ne ne ano

Informace
o barvě
v různých
modelech

ano ano ano ano ano ano

Kanály ano ano ano ano ne ne

Kapátko ano ano ano ano ano ano

Maska vrstvy ano ano ano ano ano ano

Maska vrstvy
úprav

ano ano ano ne ano ne

Míchání
kanálů filtr

ano ano ano ano ano ano

Odstín a sy-
tost filtr

ano ano ano ano ano ano

Úrovně, šedé
kapátko

ano ano ne ano ne ano

Vrstvy ano ano ano ano ano ano

Vrstvy úprav ano ano ano ne ano ano

Vyběr barvy
z palety

ano ano ano ano ano ano

Třetí počítačové cvičení

Třetí počítačové cvičení se zabývá formáty obrazů. Používané funkce v rámci třetího
počítačového cvičení jsou např. export do různých formátů souborů, export s rozší-
řenými možnostmi nastavení s náhledovým oknem a zobrazení velikosti souboru.

42



Používané formáty souborů jsou: BMP, GIF, JPEG, JPEG 2000, PNG8, PNG24,
TIFF. V tab. 2.8 je provedeno srovnání podpory funkcí používaných v rámci třetího
počítačového cvičení jednotlivými programy.

Tab. 2.8: Srovnání podporovaných funkcí používaných ve 3. počítačovém cvičení.

Funkce Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

Uložení s
náhledem
kvality

ano ano ano plugin ano ano

Uložení do
BMP

ano ano ne ano ano ano

Uložení do
GIF

ano ano ano ano ano ano

Uložení do
JPEG

ano ano ano ano ano ano

Uložení do
JPEG 2000

ano ano ne plugin ne ano

Uložení do
PNG8

ano ano ano ano ano ano

Uložení do
PNG24

ano ano ano ano ano ano

Uložení do
TIFF

ano ano ano ano ano ano

Převedení
obrazu do
stupňů šedi

ano ano ano ano ano ano

Čtvrté počítačové cvičení

Čtvrté počítačové cvičení se zabývá úpravou bitmapových obrazů. Používané funkce
v rámci čtvrtého počítačového cvičení jsou např. histogram, nástroje k úpravě po-
dexponované fotografie, nástroje pro nedestruktivní úpravu, převedení obrazu do
indexované barvy, aplikace lineárních filtrů na obrázek, změna rozlišení a velikosti
obrazu, volba interpolačního jádra při převzorkování. V tab. 2.9 je provedeno srov-
nání podpory funkcí používaných v rámci čtvrtého počítačového cvičení jednotlivými
programy.
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Tab. 2.9: Srovnání podporovaných funkcí používaných ve 4. počítačovém cvičení.

Funkce Photoshop

CS6 Exten-

ded

Photoshop

CC 2021

Affinity

Photo

GIMP Zoner

Photo

Studio X

Corel Pa-

intShop Pro

2022

Filtr doostřit ano ano ano ano ano ano

Histogram,
jednotlivé
kanály

ano ano ano ano ano ano

Horní propust ano ano ano ano ano ano

Indexovaná
barva

ano ano ne ano ne ano

Jas a kontrast ano ano ano ano ano ano

Konvoluční
matice

ano ano ne ano ano ano

Křivky ano ano ano ano ano ano

Nastavení
krytí vrstvy

ano ano ano ano ano ano

Nástroje
zesvětlit
a ztmavit

ano ano ano ano ano ano

Stíny a světla ano ano ano ano ano ano

Uložení do pa-
lety, nastavení
počtu barev,
automatické
vytvoření
palety, roz-
ptylování
chyby

ano ano ano ano ano ano

Uložení do
palety, přidání
vynucené
barvy

ano ano ne ne ne ne

Úrovně, šedé
kapátko

ano ano ne ano ne ano

Volba interpo-
lačního jádra

ano ano ano ano ano ano

Volba režimu
prolnutí
vrstvy

ano ano ano ano ano ano

Vrstvy ano ano ano ano ano ano

Vrstvy úprav ano ano ano ne ano ano

Změna
velikosti
a rozlišení

ano ano ano ano ano ano
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2.6.6 Cena programů

Cena programu Adobe Photoshop CS6 Extended byla v roce 2012 349 $ za jednu
trvalou licenci určenou pro akademiky [61]. Tuto verzi již není možné koupit, je bez
podpory vývojářů, nejsou k dispozici aktualizace, opravy chyb.

Společnost Adobe v roce 2013 přešla na systém předplatného, už si nekupujete
trvalou licenci, ale program si předplatíte na určitou dobu [62]. Tato výrazná změna
financování vyvolala mezi dlouhodobými uživateli negativní reakce. Výhodou tohoto
předplatného je, že máte k dispozici nejnovější verzi programu, aktualizace [63]. Cena
předplatného Adobe Creative Cloud je pro jednoho studenta 235,95 € za první rok
předplatného, poté se cena zvýší na 362,75 € za rok [64]. Toto předplatné umožňuje
přístup k více než 20 aplikacím, součástí je i Adobe Photoshop CC 2021. Cena před-
platného Adobe Creative Cloud pro jeden počítač, který bude sdílený více studenty
v počítačové učebně je 330 € bez DPH za rok [64].

Cena programu Affinity Photo je za jednu trvalou licenci 1 490 Kč [65]. Student-
ská licence nebo licence určená pro školy bohužel není v nabídce.

GIMP je nekomerční, je k dispozici pro uživatele zdarma [66].
Firma Zoner nabízí studentskou, nekomerční licenci, která stojí 999 Kč za rok.

Je nabízena i trvalá studentská licence, která stojí 1 499 Kč [67]. Zoner Photo Stu-
dio X nabízí licenci určenou pro vysoké školy, jedna nekomerční licence s časově
neomezenou platností stojí od 999 Kč [68].

Cena programu Corel PaintShop Pro 2022 je za jednu trvalou studentskou licenci
39,99 $ [69]. Jedna licence tohoto programu určená pro školy je za stejnou cenu.

Porovnání finančních nákladů pro studenta je znázorněné v tab. 2.10, pro školu
v tab. 2.11. Grafické porovnání cen programů pro školu za dobu 5 let je znázorněno
na obr. 2.1. Pro přepočet měn byl použit kurz 1 € = 24,665 Kč, 1 $ = 23,336 Kč [70].

Obr. 2.1: Grafické porovnání cen programů pro školu za 1 licenci za dobu 5 let.
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Tab. 2.10: Srovnání ceny za 1 licenci pro studenta.

Cena Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

Za 1 rok 8 144 Kč 5 820 Kč 1 490 Kč 0 Kč 999 Kč 933 Kč
Za 5 let 8 144 Kč 41 609 Kč 1 490 Kč 0 Kč 1 499 Kč 933 Kč

Tab. 2.11: Srovnání ceny za 1 licenci pro školu.

Cena Photoshop
CS6 Ex-
tended

Photoshop
CC 2021

Affinity
Photo

GIMP Zoner
Photo
Studio X

Corel Pa-
intShop
Pro 2022

Za 1 rok 8 144 Kč 8 139 Kč 1 490 Kč 0 Kč 999 Kč 933 Kč
Za 5 let 8 144 Kč 40 697 Kč 1 490 Kč 0 Kč 999 Kč 933 Kč

2.6.7 Shrnutí porovnání a výběr programů

Porovnáme-li verze Photoshopu, zjistíme, že mezi verzí CS6 a CC 2021 je 8 let roz-
díl. Verze CC 2021 neumožňuje zakoupení trvalé licence, je možné pouze předplatné
Adobe Creative Cloud. Použití Adobe Creative Cloud má řadu výhod: uložení dat
do cloudu umožní práci se soubory z více zařízení, z různých aplikací, lepší zá-
loha a synchronizace dat. Výhodou verze CC 2021 jsou pokročilé funkce pro výběr,
rozostření, úpravy RAW formátu, podpora bezeztrátové komprese PNG, podpora
formátu HEIF [35], 32bitové vrstvy úprav pro jas, kontrast, křivky atd. Další výho-
dou je hardwarová akcelerace procesů, která umožní rychlejší práci v programu na
moderních počítačích s vysokým výpočetním výkonem. Z pohledu využití ve výuce
zpracování obrazu nová verze Photoshopu nepřináší velké výhody, funkce používané
ve výuce podporuje i starší verze programu. Finanční náročnost verze CC 2021 je pro
školu výrazně vyšší v porovnání se starší verzí CS6, viz tab. 2.11. Z těchto důvodů
nedoporučuji Adobe Photoshop CC 2021 k výběru.

Affinity Photo má přivětivé uživatelské prostředí, podobné Adobe Photoshop,
podporuje operační systémy Microsoft Windows a macOS. Podporuje barevné mo-
dely CMYK, RGB, stupně šedi a barevný prostor Lab. Výhodou Affinity Photo
je přehledný náhled tiskového výstupu a kontroly gamutu. Nevýhodou tohoto pro-
gramu je nemožnost uložení bitmapy do formátu BMP, JPEG 2000, nepodporuje
např. filtr typu konvoluční matice, šedé kapátko u úrovní. Z těchto důvodů nedopo-
ručuji tento program k výběru.
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GIMP podporuje všechny operační systémy, má přehledné uživatelské prostředí,
nevyžaduje instalaci, uživatelský účet a je snadno modifikovatelný. Další výhodou
je cena, v budoucnu mohou absolventi předmětu Základy počítačové sazby a gra-
fiky použít tento program zdarma pro zpracování obrazu nebo vytvoření bitmapové
grafiky. Nevýhodou programu je nemožnost vrstev úprav, tato funkcionalita však
může být v následujících letech vývojáři přidána. Z důvodu ceny, podporovaných
operačních systémů, funkcí, možnosti rozšíření pluginy doporučuji tento program
k výběru pro všechna počítačová cvičení.

Zoner Photo Studio X má méně přívětivé uživatelské prostředí než ostatní pro-
gramy. Podporuje pouze operační systém Microsoft Windows a pouze barevný model
RGB. Z hlediska podporovaných funkcí nepodporuje např. barevný prostor LAB, ka-
nály, šedé kapátko u úrovní, režim indexovaná barva, uložení souboru do formátu
JPEG 2000. Z těchto důvodů nedoporučuji tento program k výběru.

Corel PaintShop Pro 2022 má přívětivé, intuitivní prostředí, podobné Adobe
Photoshop. Podporuje pouze operační systém Microsoft Windows, nepodporuje např.
barevný model CMYK, barevný prostor Lab, kanály, kontrolu gamutu, náhled tis-
kového výstupu a češtinu. Cena programu je 39,99 $ za jednu trvalou licenci. Dopo-
ručuji program k výběru z důvodu podpory vrstev úprav, všech exportních formátů
používaných ve třetím cvičení a funkcí používaných ve čtvrtém cvičení.

Pro výuku zpracování obrazu, jako alternativu k programu Adobe Photoshop
CS6 Extended byly vybrány programy GIMP a Corel PaintShop Pro 2022.
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3 Návody k 1. počítačovému cvičení

3.1 Základní ovládání programu Gimp, správa barev
Cíl
Cílem cvičení je seznámit se s ovládáním programu GIMP, naučit se názvosloví
používané při ovládání programu. Obsahem cvičení je: vytvoření nového plátna,
otevření souboru, možnosti dialogových oken, uložení do souboru, nastavení správy
barev.

3.1.1 Seznámení se s prostředím programu GIMP

Po spuštění programu GIMP se dostanete do základního rozhraní, viz obr. 3.1.
V horní levé části je hlavní menu programu. V levé části je panel nástrojů, který ob-
sahuje sadu ikon jednotlivých nástrojů [1]. Pod panelem nástrojů se nachází dialog
volby nástrojů, zde jsou zobrazeny informace o právě zvoleném nástroji. Uprostřed
je pracovní plocha. V pravé části jsou dialogová okna, v horní liště dialogového
okna můžete přepínat zobrazovaná okna. Ve spodní části dialogového okna je menu
spodního dialogového okna. U okna Vrstvy jsou tlačítka pro vytvoření nové vrstvy,
skupiny, přenesení vrstvy, vytvoření kopie vrstvy, sloučení vrstvy, vytvoření masky,
odstranění vrstvy.

Obr. 3.1: Úvodní prostředí programu GIMP.
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Vytvoření nového plátna
Vytvoření nového plátna, souboru provedete v menu programu Soubor > Nový...
nebo klávesovou zkratkou Ctrl + N , zobrazí se dialogové okno, viz obr. 3.2. V dialo-
govém okně můžete nastavit velikost, rozlišení, barevný prostor, barevnou hloubku,
gama, barevný profil a výplň nového plátna. Velikost plátna je v různých jednotkách,
např. pixely, palce, centimetry. Rozlišení nastavte podle potřeby použití obrazu, pro
grafiku určenou pro zobrazení na monitoru je vhodné použít hodnotu 96 [2]. Barevný
model nastavte na RGB, když potřebujete zpracovat grafiku určenou pro zobrazení
na monitoru. Barevný model nastavte na CMYK, pokud potřebujete zpracovat gra-
fiku určenou pro tisk [3].

Obr. 3.2: Dialogové okno pro vytvoření nového plátna.

Otevření souboru
Otevření souboru z počítače provedete v menu programu Soubor > Otevřít...,
klávesovou zkratkou Ctrl + O [4] nebo dvojklikem na pracovní plochu bez vytvo-
řeného plátna, zobrazí se dialogové okno s adresářem souborů, viz obr. 3.3. V dialo-
govém okně rozbalte nabídku Zvolte typ souboru, v této nabídce jsou zobrazeny
podporované formáty souborů podle přípony.

Obrázek můžete otevřít přetažením souboru ze složky. Při otevírání obrázku
z webu nemusíte obrázek ukládat na disk, ale můžete ho zkopírovat do schránky
a poté vložit.
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Obr. 3.3: Dialogové okno pro otevření.

Výběr nástroje
Nástroje můžete vybírat v panelu nástrojů. Většina nástrojů má více variant, va-
rianty nástroje zobrazíte kliknutím pravým tlačítkem myši na ikonu nástroje [4].
U nástroje je zobrazena klávesová zkratka, viz obr. 3.4. Pro efektivní práci je vhodné
se naučit u nejčastěji používaných nástrojů klávesové zkratky.

Obr. 3.4: Panel nástrojů, varianty nástroje.

Dialogová okna
Dialogová okna můžete vyvolat v menu programu Okna > Dokovatelná dialo-
gová okna. Dialogové okno můžete upravovat po kliknutí na ikonu Nastavit tuto
kartu v pravém rohu dialogového okna, viz obr. 3.5. Můžete přidat kartu, zavřít
kartu, odpojit kartu, měnit styl karty.
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Obr. 3.5: Úprava dialogového okna.

Uložení souboru
GIMP používá pro bezeztrátové uchování grafických dat formát XCF, do kterého
jsou ukládána všechna data, která program zpracovává. Do souboru se ukládají
vrstvy, výběry, kanály, průhlednost, cesty a vodítka [5]. Uložení do tohoto souboru
provedete v menu programu Soubor > Uložit jako... nebo klávesovou zkratkou
Ctrl + Shift + S [6], zobrazí se dialogové okno s adresářem souborů.

Uložení souboru do jiného formátu, než XCF provedete v menu programu Sou-
bor > Export As... nebo klávesovou zkratkou Shift + Ctrl + E, zobrazí se
dialogové okno s adresářem souborů, viz obr. 3.6. V dialogovém okně rozbalte na-
bídku Zvolte typ souboru, v této nabídce jsou zobrazeny formáty souborů podle
přípony.

Obr. 3.6: Dialogové okno pro export.
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3.1.2 Nastavení správy barev

Dialogové okno pro správu barev vyvoláte v menu programu Upravit > Před-
volby, otevře se dialogové okno, viz obr. 3.7. V okně vyberte v levém horním rohu
Správa barev [7]. Nastavení správy barev a změny nastavení provádějte při nevy-
tvořeném plátně v základním rozhraní programu, viz obr. 3.1.

Pro nahrání barevného profilu monitoru1 a tiskárny z disku rozbalte u mož-
ností Profil monitoru: a Profil náhledu tiskového výstupu: nabídku a zvolte
Vyberte barevný profil z disku..., otevře se dialogové okno s adresářem sou-
borů. U možností Cíl vykreslování: nastavte volbu přepočtu barev mezi zvole-
nými gamuty – perceptuální, relativní kolorimetrický, sytost, absolutní kolorimet-
rický. U možnosti Mark out of gamut colors nastavte barvu, která se zobrazí
při kontrole gamutu místo barvy pixelů, které jsou mimo gamut barevného profilu
CMYK.

Obr. 3.7: Dialogové okno pro správu barev.

1Tato kolonka je pojmenována nevhodně, s největší pravděpodobností se jedná o pracovní pro-
stor RGB.

5



Náhled tiskového výstupu
Náhled tiskového výstupu provedete v menu programu Zobrazení > Správa ba-
rev > Náhled tiskového výstupu, v dialogovém okně správy barev nesmí být
zvolená možnost Mark out of gamut colors.

Náhled kontroly gamutu
Náhled kontroly gamutu provedete v menu programu Zobrazení > Správa ba-
rev > Náhled tiskového výstupu, v dialogovém okně správy barev musí být
zvolená možnost Mark out of gamut colors [8]. Změnu nastavení proveďte při
nevytvořeném plátně v základním rozhraní programu, viz obr. 3.1.

3.1.3 Kontrolní otázky

1. Jaký barevný model je potřeba nastavit, pro zpracování grafiky určené pro
zobrazení na monitoru?

2. Co je to gamut?
3. Co se stane, když zvolená barva nepatří do rozsahu gamutu výstupního zaří-

zení?
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3.2 Základní ovládání programu Corel PaintShop Pro
2022, správa barev

Cíl
Cílem cvičení je seznámit se s ovládáním programu Corel PaintShop Pro 2022, na-
učit se názvosloví používané při ovládání programu. Obsahem cvičení je: vytvoření
nového plátna, otevření souboru, možnosti dialogových oken, uložení do souboru,
nastavení správy barev.

3.2.1 Seznámení se s prostředím programu Corel PaintShop Pro
2022

Po spuštění programu Corel PaintShop Pro 2022 se dostanete do úvodní nabídky,
v záložce Workspace zvolte možnost Complete a potvrďte ji tlačítkem Apply, viz
obr. 3.8. Do rozhraní určeného pro editaci bitmap se dostanete kliknutím na tlačítko
Edit v horní střední části úvodní nabídky.

Obr. 3.8: Úvodní nabídka programu Corel PaintShop Pro 2022.

V levé horní části rozhraní pro editaci bitmap je hlavní menu programu, viz
obr. 3.9. Pod ním se nachází panel funkcí, ve kterém jsou tlačítka pro vytvoření
nového plátna, otevření, uložení souboru atd. Pod panelem funkcí je dialog volby
nástrojů, zde jsou zobrazeny informace a možnosti právě zvoleného nástroje. V levé
části je panel nástrojů, který obsahuje sadu ikon jednotlivých nástrojů. Uprostřed
je pracovní plocha. Ve spodní části je panel Organizer. V pravé části jsou dialogová
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okna. V levém dolním rohu dialogových oken je menu dialogového okna Layers, zde
jsou tlačítka pro vytvoření nové vrstvy, skupiny, masky, vrstvy úprav. Pro efektivní
práci doporučuji zavřít dialogové okno Learning Center a panel Organizer.

Obr. 3.9: Rozhraní pro editaci bitmap.

Vytvoření nového plátna
Vytvoření nového plátna, souboru provedete v menu programu File > New...,
klávesovou zkratkou Ctrl + N nebo kliknutím na první tlačítko v panelu funkcí,
zobrazí se dialogové okno, viz obr. 3.10. V dialogovém okně můžete nastavit velikost,
rozlišení, barevný model, barevnou hloubku, výplň nového plátna, určení použití
plátna pro bitmapovou nebo vektorovou grafiku. Velikost plátna je v různých jed-
notkách, např. pixely, palce, centimetry. Rozlišení nastavte podle potřeby použití
obrazu, pro grafiku určenou pro zobrazení na monitoru je vhodné použít hodnotu
96 [1]. Barevný model nastavte na RGB, když potřebujete zpracovat grafiku určenou
pro zobrazení na monitoru, barevný model nastavte na CMYK, pokud potřebujete
zpracovat grafiku určenou pro tisk [2].

Otevření souboru
Otevření souboru z počítače provedete v menu programu File > Open..., kláve-
sovou zkratkou Ctrl + O nebo kliknutím na 3. tlačítko v panelu funkcí, zobrazí se
dialogové okno s adresářem souborů, viz obr. 3.11. V dialogovém okně rozbalte na-
bídku All files, v této nabídce jsou zobrazeny podporované formáty souborů podle
přípony.
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Obr. 3.10: Dialogové okno pro vytvoření nového plátna.

Obrázek můžete otevřít přetažením souboru ze složky. Při otevírání obrázku
z webu nemusíte obrázek ukládat na disk, ale můžete ho zkopírovat do schránky
a poté vložit do vytvořeného plátna.

Obr. 3.11: Dialogové okno pro otevření souboru.

Výběr nástroje
Nástroje můžete vybírat v panelu nástrojů. Většina nástrojů má více variant, vari-
anty nástroje zobrazíte kliknutím na šipku u ikony nástroje. U většiny nástrojů je
zobrazena klávesová zkratka, viz obr. 3.12. Pro efektivní práci je vhodné se naučit
u nejčastěji používaných nástrojů klávesové zkratky.
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Obr. 3.12: Panel nástrojů, varianty nástroje.

Dialogová okna
Dialogová okna můžete vyvolat v menu programu View > Palettes [3]. Dialo-
gové okno můžete upravovat po kliknutí na ikony v pravém horním rohu okna, viz
obr. 3.13. Můžete okno zavřít, skrýt, uchopením nadpisu okna můžete okno přemís-
tit.

Obr. 3.13: Úprava dialogového okna.

Uložení souboru
Corel PaintShop Pro 2022 používá pro bezeztrátové uchování grafických dat formát
PSP, do kterého jsou ukládána všechna data, která program zpracovává. Do souboru
se ukládají např. vrstvy, masky, bitmapové soubory [4]. Uložení dat do souboru
provedete v menu programu File > Save As..., klávesovou zkratkou F12 nebo
kliknutím na šesté tlačítko v panelu funkcí, zobrazí se dialogové okno s adresářem
souborů, viz obr. 3.14. V dialogovém okně rozbalte nabídku Uložit jako typ: v této
nabídce jsou zobrazeny podporované formáty souborů podle přípony.
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Obr. 3.14: Dialogové okno pro uložení.

Uložení souboru do formátu bitmapové grafiky s rozšířenými možnostmi nasta-
vení provedete v menu programu File > Export..., můžete vybrat ze tří možností
JPEG Optimizer..., GIF Optimizer..., PNG Optimizer..., zobrazí se dialo-
gové okno s rozšířenými možnostmi nastavení, včetně zobrazení náhledu.

3.2.2 Nastavení správy barev

Nastavení pracovního prostoru RGB a barevného profilu CMYK provedete v menu
programu File > Color Management > Color Working Space... [5], zobrazí
se dialogové okno, viz obr. 3.15. U možností Color Working Space: a CMYK
Profile: rozbalte nabídku a zvolte požadovaný pracovní prostor RGB a barevný
profil CMYK.

Obr. 3.15: Dialogové okno pro nastavení pracovního prostoru RGB a profilu CMYK.
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Dialogové okno pro správu barev vyvoláte v menu programu File > Color
Management > Color Management, u možností Profil monitoru: a Profil
tiskárny: rozbalte nabídku a zvolte požadovaný profil [6], viz obr. 3.16. U možnosti
Vykreslení: rozbalte nabídku, ve které zvolte volbu přepočtu barev mezi zvole-
nými gamuty: obrázky, obtah, grafika, shoda barev. Volby přepočtu pravděpodobně
odpovídají volbám: perceptuální, relativní kolorimetrická, sytostní, absolutní kolo-
rimetrická.

Obr. 3.16: Dialogové okno pro správu barev.

Náhled tiskového výstupu
Náhled tiskového výstupu není v této verzi programu podporovaný.

Náhled kontroly gamutu
Náhled kontroly gamutu není v této verzi programu podporovaný.

3.2.3 Kontrolní otázky

1. Jaký barevný model je potřeba nastavit, pro zpracování grafiky určené pro
zobrazení na monitoru?

2. Co je to gamut?
3. Co se stane, když zvolená barva nepatří do rozsahu gamutu výstupního zaří-

zení?
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4 Návody k 2. počítačovému cvičení

4.1 GIMP – Reprezentace obrazu v počítači
Cíl
Cílem cvičení je pochopit princip nedestruktivní úpravy obrazu. Obsahem cvičení je:
výběr barvy v různých barevných modelech, prozkoumání barevných složek, vrstvy,
převedení obrazu na stupně šedi, korekce vyvážení bílé, masky.

4.1.1 Výběr barvy z palety v různých barevných modelech

Výběr barvy popředí provedete v panelu nástrojů kliknutím na levou horní ikonu, viz
obr. 4.1. Výběr barvy pozadí provedete kliknutím na pravou dolní ikonu. Kliknutím
na ikonu v pravém horním rohu vyměníte barvu popředí a pozadí [1]. Kliknutím na
ikonu v levém dolním rohu resetujete barvu popředí na černou a barvu pozadí na
bílou.

Obr. 4.1: Panel nástrojů, výběr barvy.

Po kliknutí na ikonu výběru barvy se zobrazí dialogové okno, viz obr. 4.2. V okně
vyberte barvu, ve výchozím stavu je ve čtvercové ploše zobrazený barevný model
LCh. V pravém horním rohu okna klikněte na tlačítko HSV . V hlavní čtvercové
ploše je na svislé ose složka V, na vodorovné ose složka S. Ve svislém sloupci vpravo
od čtvercové plochy je zobrazena složka H, barevný model je trojrozměrný. Vyberte
barvu kliknutím na čtvercovou plochu a klikněte na tlačítko OK . Výběr barvy
v barevném modelu CMYK provedete kliknutím na záložku CMYK nad čtvercovou
plochou, zobrazí se posuvníky pro jednotlivé barevné složky.

Obr. 4.2: Dialogové okno Změna barvy popředí.
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4.1.2 Úkol č. 1

V tomto úkolu prozkoumejte barevné složky H, S, B u obrázku. Použijte nástroj
Odstín a sytost, měňte parametry a pozorujte změnu obrázku. V elearningu před-
mětu v sekci Reprezentace obrazu v počítači klikněte na odkaz Úkol č. 1. Po
otevření stránky uložte obrázek do počítače.

Otevření souboru
Otevření souboru z počítače provedete v menu programu Soubor > Otevřít...,
klávesovou zkratkou Ctrl + O nebo dvojklikem na pracovní plochu bez vytvořeného
plátna, zobrazí se dialogové okno s adresářem souborů, viz obr. 4.3. Vyberte stažený
soubor z adresáře souborů a klikněte na tlačítko Otevřít [1].

Obr. 4.3: Dialogové okno pro otevření.

Prozkoumání barevných složek H, S, B
Pro prozkoumání barevných složek použijte nástroj Barevná pipeta. Výběr nástroje
provedete v panelu nástrojů, kliknutím na 1. nástroj ve 3. řádku nebo použitím klá-
vesové zkratky O. V dialogu Volby nástroje zvolte možnost Použít informační
okno [2], viz obr. 4.10. Klikněte na model, zobrazí se dialogové okno Barevná pi-
peta, viz obr. 4.4. V okně zvolte barevný model HSV a pozorujte hodnoty složek
H, S, V. Zjistěte, jakou hodnotu má parametr S na povrchu a podstavě modelu.

Obr. 4.4: Dialogové okno Barevná pipeta.
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Nástroj Odstín a sytost
Nástroj Odstín a sytost vyvoláte v menu programu Barvy > Odstín-sytost...,
zobrazí se dialogové okno, viz obr. 4.5. Změňte hodnotu u posuvníku Odstín a po-
zorujte změnu v obrázku. Změníte-li hodnotu u posuvníku Sytost na minimum,
převedete obrázek na stupně šedi.

Obr. 4.5: Dialogové okno Odstín-sytost.

4.1.3 Vrstvy

Vrstvy se používají k nedestruktivní úpravě obrazu, můžete si je představit jako
průhledné fólie navrstvené na sebe, do kterých se přidávají data [3]. Vrstvy je vhodné
použít při úpravách, jako jsou např. fotomontáž, přidání textu, grafiky. Co je ve vyšší
vrstvě, zakrývá to, co je v nižší vrstvě.

Dialogové okno Vrstvy se nachází ve spodní části dialogových oken, viz obr. 4.6.
Případně jej můžete vyvolat v menu programu Okna > Dokovatelná dialogová
okna > Vrstvy. Ve spodní části okna je menu, zde jsou tlačítka pro vytvoření nové
vrstvy, skupiny, přenesení vrstvy, vytvoření kopie vrstvy, sloučení vrstvy, přidání
masky, odstranění vrstvy.

Vytvoření nové vrstvy
Vytvoření nové vrstvy provedete v menu programu Vrstva > Nová vrstva...,
klávesovou zkratkou Shift + Ctrl + N nebo v menu dialogového okna Vrstvy, klik-
nutím na 1. tlačítko zleva Vytvořit novou vrstvu a přidat ji do obrázku [4],
zobrazí se dialogové okno Nová vrstva, viz obr. 4.7. Nastavte parametry vrstvy a klik-
něte na tlačítko OK .
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Obr. 4.6: Dialogové okno Vrstvy.

Obr. 4.7: Dialogové okno Nová vrstva.

Duplikace vrstvy
Vrstvu duplikujete v menu programu Vrstva > Duplikovat vrstvu, klávesovou
zkratkou Ctrl + Shift + D, kliknutím pravého tlačítka na vrstvu a zvolením mož-
nosti Duplikovat vrstvu nebo kliknutím na 5. tlačítko zleva v menu dialogového
okna Vrstvy Vytvořit kopii vrstvy a přidat ji do obrázku.

Změna krytí vrstvy
Parametr krytí vyjadřuje do jaké míry se daná vrstva v obraze uplatňuje. Změnu
krytí vrstvy provedete změnou hodnoty u posuvníku Krytí v horní části okna Vrstvy
nebo kliknutím pravého tlačítka na vrstvu a zvolením možnosti Upravit vlast-
nosti vrstvy..., otevře se dialogové okno, ve kterém u posuvníku Krytí: změňte
hodnotu [4]. Šedobílé kostečky u vrstvy znamenají průhlednou, viz vrchní vrstva na
obr. 4.6. Zneviditelní vrstvy provedete kliknutím na oko u vrstvy.
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Změna režimu prolnutí vrstvy
Změnu režimu prolnutí vrstvy provedete rozbalením nabídky Režim v horní části
okna Vrstvy a zvolením požadované možnosti nebo kliknutím pravého tlačítka na
vrstvu a zvolením možnosti Upravit vlastnosti vrstvy..., otevře se dialogové
okno, ve kterém u možnosti Režim: zvolte požadovanou možnost.

Přejmenování vrstvy
Vrstvu přejmenujete dvojklikem na název vrstvy nebo kliknutím pravého tlačítka
na vrstvu a zvolením možnosti Upravit vlastnosti vrstvy..., otevře se dialogové
okno, ve kterém u možnosti Název vrstvy: zvolte název vrstvy.

Změna pořadí vrstev
Pořadí vrstev můžete měnit kliknutím na 3. tlačítko – Přenést tuto vrstvu v zá-
sobníku vrstev o stupeň výš a 4. tlačítko – Přenést tuto vrstvu v zásobníku
vrstev o stupeň níž zleva v menu dialogového okna Vrstvy nebo uchopením vrstvy
a přetažením.

Odstranění vrstvy
Vrstvu odstraníte v menu programu Vrstva > Odstranit vrstvu, kliknutím pra-
vého tlačítka na vrstvu a zvolením možnosti Odstranit vrstvu nebo kliknutím na
1. tlačítko zprava v menu dialogového okna Vrstvy Odstranit tuto vrstvu.

4.1.4 Úkol č. 2

Vrstvy úprav nejsou v této verzi programu podporované.

4.1.5 Úkol č. 3

V tomto úkolu převeďte obrázek na stupně šedi různými způsoby. V elearningu
předmětu v sekci Reprezentace obrazu v počítači klikněte na odkaz Úkol č. 3.
Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu
uvedeného v kapitole 4.1.2.

Převedení obrazu na stupně šedi
Převedení obrazu na stupně šedi provedete v menu programu Obrázek > Režim >
Odstíny šedi [1]. Zobrazte okno Kanály, zůstal 1 kanál. Pro vrácení převodu
použijte klávesovou zkratku Ctrl + Z .

Nástroj Odstín a sytost
Nástroj Odstín a sytost vyvoláte v menu programu Barvy > Odstín-sytost...,
zobrazí se dialogové okno, viz obr. 4.5. Změňte hodnotu u posuvníku Sytost na
minimum a klikněte na tlačítko OK .
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Nástroj Míchání kanálů
Nástroj Mono mixér vyvoláte v menu programu Barvy > Komponenty > Mono
mixér..., zobrazí se dialogové okno, viz obr. 4.8. Vyzkoušejte měnit hodnoty u jed-
notlivých posuvníků, pozorujte změnu obrazu. Součet hodnot u posuvníků by měl
být 1. Když bude součet méně než 1, dojde k ztmavení obrazu, když bude součet
více než 1, dojde k zesvětlení.

Obr. 4.8: Dialogové okno Mono mixér.

Kanál L z barevného modelu Lab
Nástroj Dekomponovat vyvoláte v menu programu Barvy > Komponenty > De-
komponovat..., zobrazí se dialogové okno, viz obr. 4.9. V okně u možnosti Ba-
revný model: zvolte LAB a klikněte na tlačítko OK . Nástroj rozloží obrázek do
jednotlivých složek podle zvoleného barevného modelu/prostoru [5]. Vytvoří se nové
plátno, ve kterém se vytvoří vrstvy L, A, B, z nichž je obrázek složený, zobrazte
vrstvu L.

Obr. 4.9: Dialogové okno Dekompozice.

4.1.6 Nástroj Barevná pipeta, nastavení velikosti vzorku

Nástroj Barevná pipeta slouží k nabrání barvy. Výběr nástroje provedete v panelu
nástrojů, kliknutím na 1. nástroj ve 3. řádku nebo použitím klávesové zkratky O.
Kliknutím do obrázku se do barvy popředí načte vybraná barva. Kliknutím do ob-
rázku se stisknutou levou klávesou Ctrl se do barvy pozadí načte vybraná barva.
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Změnu velikosti, z jak velké plochy se má barva vybrat a zprůměrovat, provedete
v dialogu Volby nástroje zvolením možnosti Průměrný vzorek, viz obr. 4.10.
Velikost plochy nastavíte posuvníkem Poloměr [2].

Obr. 4.10: Volby nástroje Barevná pipeta.

4.1.7 Úkol č. 1 – teplota chromatičnosti a vyvážení bílé

V tomto úkolu se dozvíte, jak kompenzovat vyvážení bílé pomocí nástroje Úrovně.
V elearningu předmětu v sekci Reprezentace obrazu v počítači klikněte v části
Teplota chromatičnosti a vyvážení bílé na odkaz Úkol č. 1. Po otevření stránky
uložte obrázky do počítače. Horní obrázek otevřete podle postupu uvedeného v ka-
pitole 4.1.2.

Korekce vyvážení bílé pomocí nástroje Úrovně
Nástroj Úrovně vyvoláte v menu programu Barvy > Úrovně..., zobrazí se dialo-
gové okno [6]. V okně zvolte šedé kapátko, které je na obr. 4.11 v červeném kruhu.
Na obrázku vyberte místo, které by mělo být šedé a klikněte na něj. Program pře-
počítá obrázek tak, aby místo kam kliknete bylo šedé. Jako vzor pro kompenzaci
použijte spodní obrázek.

4.1.8 Úkol č. 2 – teplota chromatičnosti a vyvážení bílé

V tomto úkolu neutralizujte barevný nádech obrázku pomocí vrstvy s doplňkovou
barvou. V elearningu předmětu v sekci Reprezentace obrazu v počítači klikněte
v části Teplota chromatičnosti a vyvážení bílé na odkaz Úkol č. 2 – složitější,
pro zájemce. Po otevření stránky uložte obrázek do počítače. Obrázek otevřete
podle postupu uvedeného v kapitole 4.1.2.

V obrázku vyberte nástrojem Barevná pipeta místo, které by mohlo být ve sku-
tečnosti neutrálně šedé. Zvolte nástroj podle postupu uvedeného v kapitole 4.1.6
a klikněte na místo v obrázku. Vytvořte novou vrstvu podle postupu uvedeného
v kapitole 4.1.3, zvolte nástroj Plechovka kliknutím na 1. nástroj ve 2. řádku v pa-
nelu nástrojů nebo použitím klávesové zkratky Shift + B a kliknutím na vrstvu
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Obr. 4.11: Dialogové okno Úrovně.

vyplňte vrstvu vybranou barvou. Pro vytvoření vrstvy s doplňkovou barvou zvolte
v menu programu Barvy > Invertovat.

Nastavte režim prolnutí vrstvy na barva. Změnu režimu prolnutí vrstvy provedete
podle postupu uvedeného v kapitole 4.1.3, zvolte režim HSL Color . Upravte krytí
vrstvy tak, aby byl obrázek neutrální. Změnu krytí vrstvy provedete podle postupu
uvedeného v kapitole 4.1.3. Zkontrolujte, zda zvolené místo je neutrální, zamyslete
se nad tím.

4.1.9 Úkol č. 3 – teplota chromatičnosti a vyvážení bílé

V tomto úkolu neutralizujte barevný nádech obrázku pomocí barevného terčíku
z druhého obrázku. V elearningu předmětu v sekci Reprezentace obrazu v po-
čítači klikněte v části Teplota chromatičnosti a vyvážení bílé na odkaz
Úkol č. 3. Po otevření stránky uložte obrázky do počítače. Obrázek s barevným
terčíkem otevřete podle postupu uvedeného v kapitole 4.1.2 a poté ze složky pře-
táhněte obrázek bez barevného terčíku do pracovní plochy. Obrázek bez barevného
terčíku přesuňte nahoru, aby nezakrýval spodní řádek tabulky, viz obr. 4.12. Přesun
provedete volbou nástroje Přesun kliknutím na 1. nástroj v 1. řádku v panelu ná-
strojů nebo použitím klávesové zkratky M . Klikněte na vrstvu, držte a tahem myši
přesuňte.
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Obr. 4.12: Pracovní plocha pro vyvážení bílé.

Korekce vyvážení bílé pomocí nástroje Úrovně
V okně Vrstvy zvolte vrchní vrstvu bez barevného terčíku. Nástroj Úrovně vyvoláte
v menu programu Barvy > Úrovně... [6], zobrazí se dialogové okno, viz obr. 4.11.
Klikněte šedým kapátkem na odstíny šedi ve spodním řádku barevného terčíku,
pozorujte změny v obrázku.

Obrázek po úpravě vyvážení bílé přesuňte dolů, aby byl celý viditelný v pracovní
ploše. Spodní vrstvu s barevným terčíkem zneviditelněte kliknutím na oko u vrstvy
a v menu programu zvolte Obrázek > Oříznout podle obsahu.

Prozkoumání barevných složek L, a, b
Prozkoumejte barevné složky L, a, b čtverečků ve spodním řádku barevného terčíku.
Postupujte podle postupu uvedeného v kapitole 4.1.2, v dialogovém okně Barevná
pipeta, zvolte barevný model CIE LAB. Jaké hodnoty barevných složek by měly
mít čtverečky s odstíny šedi? Jaké hodnoty jste zjistili?

4.1.10 Maska vrstvy

Maska vrstvy určuje viditelnost vrstvy, je to nedestruktivní úprava obrazu [7]. Pokud
je maska bílá, má funkci úplného krytí, vrstva je viditelná. Pokud je maska černá, má
funkci úplné průhlednosti, vrstva je průhledná. Stupně šedi značí postupný přechod
mezi úplným krytím a průhledností.

Vytvoření masky
Vytvoření masky vrstvy provedete v menu programu Vrstva > Maska > Přidat
masku vrstvy..., v menu dialogového okna Vrstvy, kliknutím na 2. tlačítko zprava
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Přidat masku umožňující nedestruktivní úpravy průhlednosti nebo klik-
nutím pravého tlačítka na vrstvu a zvolením možnosti Přidat masku vrstvy...,
otevře se dialogové okno, viz obr. 4.13. V okně zvolte možnost Bílá (úplné krytí)
a klikněte na tlačítko Přidat, maska se přidá do vrstvy, viz obr. 4.14.

Obr. 4.13: Dialogové okno Přidat masku vrstvy.

Obr. 4.14: Vrstva s maskou.

Obsah masky zobrazíte kliknutím na masku vrstvy se stisknutou levou klávesou
Alt. Masku vypnete kliknutím na masku vrstvy se stisknutou levou klávesou Ctrl,
maska se ohraničí červenou barvou.

Změna výplně masky
Změnu výplně masky provedete kliknutím na masku vrstvy a použitím nástroje Ště-
tec. Výběr nástroje provedete v panelu nástrojů, kliknutím na 2. nástroj ve 2. řádku
nebo použijte klávesovou zkratku P. Nastavte barvu popředí na černou nebo stupně
šedi a kreslete do obrázku.

Odstranění masky
Odstranění masky vrstvy provedete v menu programu Vrstva > Maska > Od-
stranit masku vrstvy nebo kliknutím pravého tlačítka na vrstvu a zvolením mož-
nosti Odstranit masku vrstvy [8].

4.1.11 Kontrolní otázky

1. Co je to nedestruktivní úprava?
2. Jakými způsoby můžete obraz převést na stupně šedi?
3. Co znamená vyvážení bílé?

10



Literatura
[1] VYBÍRAL, Josef. GIMP: praktická uživatelská příručka. 2. aktualiz. vyd. Brno:

Computer Press, 2008. 223s. ISBN 978-80-251-1945-7.

[2] GIMP Documentation. Color Picker Tool [online]. [cit. 12. 2. 2022]. Dostupné
z URL: <https://docs.gimp.org/2.2/en/gimp-tool-color-picker.html>.

[3] Podpora Adobe. Základy práce s vrstvami [online]. Poslední aktualizace
23. 6. 2020 [cit. 11. 2. 2022]. Dostupné z URL: <https://helpx.adobe.com/cz/
photoshop/using/layer-basics.html>.

[4] DAVIES, Michael. Jak vytvořit novou vrstvu v GIMP (vy-
světleny všechny funkce vrstvy) [online]. [cit. 14. 1. 2022]. Do-
stupné z URL: <https://daviesmediadesign.com/cs/
how-to-create-a-new-layer-in-gimp-all-layer-features-explained/>.

[5] GIMP Documentation. Dekomponovat [online]. [cit. 11. 2. 2022]. Dostupné
z URL: <https://docs.gimp.org/2.2/cs/plug-in-decompose.html>.

[6] GIMP Documentation. Nástroj úrovně [online]. [cit. 13. 1. 2022]. Dostupné
z URL: <https://docs.gimp.org/2.2/cs/gimp-tool-levels.html>.

[7] Podpora Adobe. Masky vrstev [online]. Poslední aktualizace 23. 6. 2020
[cit. 11. 2. 2022]. Dostupné z URL: <https://helpx.adobe.com/cz/fresco/
using/layer-masks.html>.

[8] DAVIES, Michael. Masky vrstvy GIMP: vše, co potřebujete vědět [online].
[cit. 12. 2. 2022]. Dostupné z URL: <https://daviesmediadesign.com/cs/
gimp-layer-masks-everything-you-need-to-know/>.

11

https://docs.gimp.org/2.2/en/gimp-tool-color-picker.html
https://helpx.adobe.com/cz/photoshop/using/layer-basics.html 
https://helpx.adobe.com/cz/photoshop/using/layer-basics.html 
https://daviesmediadesign.com/cs/how-to-create-a-new-layer-in-gimp-all-layer-features-explained/
https://daviesmediadesign.com/cs/how-to-create-a-new-layer-in-gimp-all-layer-features-explained/
https://docs.gimp.org/2.2/cs/plug-in-decompose.html
https://docs.gimp.org/2.2/cs/gimp-tool-levels.html
https://helpx.adobe.com/cz/fresco/using/layer-masks.html
https://helpx.adobe.com/cz/fresco/using/layer-masks.html
https://daviesmediadesign.com/cs/gimp-layer-masks-everything-you-need-to-know/
https://daviesmediadesign.com/cs/gimp-layer-masks-everything-you-need-to-know/


4.2 Corel PaintShop Pro 2022 – Reprezentace obrazu
v počítači

Cíl
Cílem cvičení je pochopit princip nedestruktivní úpravy obrazu. Obsahem cvičení je:
výběr barvy v různých barevných modelech, prozkoumání barevných složek, vrstvy,
vrstvy úprav, převedení obrazu na stupně šedi, korekce vyvážení bílé, masky.

4.2.1 Výběr barvy z palety v různých barevných modelech

Výběr barvy popředí provedete v horní části okna Materials, viz obr. 4.15. V hlavní
čtvercové ploše je zobrazen barevný model HSV, na svislé ose je složka V, na vodo-
rovné ose je složka S. V horizontálním sloupci dole od čtvercové plochy je zobrazena
složka H, barevný model je trojrozměrný. Vyberte barvu kliknutím na čtvercovou
plochu. Výběr barvy v jiném barevném modelu provedete kliknutím na záložku Sli-
ders nad čtvercovou plochou, v záložce zvolte požadovaný barevný model, zobrazí
se posuvníky pro jednotlivé barevné složky [1].

Obr. 4.15: Okno Materials, výběr barvy.

Kliknutím na vrchní ikonu v levém dolním rohu okna Materials vyměníte barvu
popředí a pozadí. Kliknutím na spodní ikonu v levém dolním rohu resetujete barvu
popředí na černou a barvu pozadí na bílou.

4.2.2 Úkol č. 1

V tomto úkolu prozkoumejte barevné složky H, S, B u obrázku. Použijte nástroj
Odstín a sytost, měňte parametry a pozorujte změnu obrázku. V elearningu před-
mětu v sekci Reprezentace obrazu v počítači klikněte na odkaz Úkol č. 1. Po
otevření stránky uložte obrázek do počítače.
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Otevření souboru
Otevření souboru z počítače provedete v menu programu File > Open..., kláve-
sovou zkratkou Ctrl + O nebo kliknutím na 3. tlačítko v panelu funkcí, zobrazí
se dialogové okno s adresářem souborů, viz obr. 4.16. Vyberte soubor z adresáře
souborů a klikněte na tlačítko Otevřít [2].

Obr. 4.16: Dialogové okno pro otevření.

Prozkoumání barevných složek H, S, B
Pro prozkoumání barevných složek použijte nástroj Kapátko. Výběr nástroje pro-
vedete v panelu nástrojů, kliknutím na 4. nástroj odshora, Dropper Tool nebo
použitím klávesové zkratky E. V dialogu Volby nástroje zvolte u možnosti Color
profile: možnost HSL, viz obr. 4.17. Nástrojem klikněte na model a pozorujte hod-
noty složek H, S, L. Zjistěte, jakou hodnotu má parametr S na povrchu a podstavě
modelu.

Obr. 4.17: Nastavení nástroje Dropper Tool.

Nástroj Odstín a sytost
Nástroj Odstín a sytost vyvoláte v menu programu Adjust > Hue and Satu-
ration > Hue/Saturation/Lightness... nebo klávesovou zkratkou Shift + H ,
zobrazí se dialogové okno, viz obr. 4.18. V pravém horním rohu dialogového okna
zvolte možnost Preview on Image [3], změňte hodnotu u posuvníku Hue: a pozo-
rujte změnu v obrázku. Změníte-li hodnotu u posuvníku Saturation: na minimum,
převedete obrázek na stupně šedi.
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Obr. 4.18: Dialogové okno Hue/Saturation/Lightness.

4.2.3 Vrstvy

Vrstvy se používají k nedestruktivní úpravě obrazu, můžete si je představit jako
průhledné fólie navrstvené na sebe, do kterých se přidávají data [4]. Vrstvy je vhodné
použít při úpravách, jako jsou např. fotomontáž, přidání textu, grafiky. Co je ve vyšší
vrstvě, zakrývá to, co je v nižší vrstvě.

Dialogové okno Layers se nachází ve spodní části dialogových oken, viz obr. 4.19.
Případně jej můžete vyvolat v menu programu Palettes > Layers [3] nebo kláve-
sovou zkratkou F8 . Ve spodní části okna je menu, zde jsou tlačítka pro vytvoření
nové vrstvy, vrstvy úprav, masky, skupiny, odstranění vrstvy.

Obr. 4.19: Dialogové okno Layers.

Vytvoření nové vrstvy
Vytvoření nové vrstvy provedete v menu programu Layers > New Raster La-
yer... nebo v menu dialogového okna Layers, kliknutím na 1. tlačítko zleva a zvo-
lením možnosti New Raster Layer..., zobrazí se dialogové okno New Raster
Layer, viz obr. 4.20. Nastavte parametry vrstvy a klikněte na tlačítko OK .
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Obr. 4.20: Dialogové okno New Raster Layer.

Duplikace vrstvy
Vrstvu duplikujete v menu programu Layers > Duplicate nebo kliknutím pravého
tlačítka na vrstvu a zvolením možnosti Duplicate [2].

Změna krytí vrstvy
Parametr krytí vyjadřuje do jaké míry se daná vrstva v obraze uplatňuje. Změnu
krytí vrstvy provedete změnou hodnoty u posuvníku v horní části okna Layers nebo
kliknutím pravého tlačítka na vrstvu a zvolením možnosti Properties..., otevře se
dialogové okno, ve kterém u možnosti Opacity: změňte hodnotu. Šedobílé kostečky
u vrstvy znamenají průhlednou, viz vrchní vrstva na obr. 4.19. Zneviditelní vrstvy
provedete kliknutím na oko u vrstvy.

Změna režimu prolnutí vrstvy
Změnu režimu prolnutí vrstvy provedete rozbalením nabídky v horní části okna
Layers a zvolením požadované možnosti nebo kliknutím pravého tlačítka na vrstvu
a zvolením možnosti Properties..., otevře se dialogové okno, ve kterém u možnosti
Blend mode: zvolte požadovanou možnost [2].

Přejmenování vrstvy
Vrstvu přejmenujete kliknutím na název vrstvy nebo kliknutím pravého tlačítka
na vrstvu a zvolením možnosti Properties..., otevře se dialogové okno, ve kterém
u možnosti Name: zvolte název vrstvy.

Změna pořadí vrstev
Pořadí vrstev můžete měnit v menu programu Layers > Arrange > Move Up,
Layers > Arrange > Move Down nebo uchopením vrstvy a přetažením.
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Odstranění vrstvy
Vrstvu odstraníte v menu programu Layers > Delete, kliknutím pravého tlačítka
na vrstvu a zvolením možnosti Delete nebo kliknutím na 1. tlačítko zprava v menu
dialogového okna Layers Delete Layer .

4.2.4 Vrstvy úprav

Vrstvy úprav se používají k nedestruktivní úpravě obrazu, můžete si je představit
jako filtry, přes které se díváte na obrázek [5]. Použití vrstev úprav je výhodné pro
úpravy obrazu, odpovídají značkování u dokumentu. Nastavení vrstvy úprav můžete
později vyvolat dvojklikem na vrstvu úprav. Můžete měnit krytí vrstvy a tím určit
do jaké míry se daná vrstva úprav v obraze uplatňuje. Duplikaci, změnu krytí,
režimu prolnutí, přejmenování, pořadí, odstranění vrstvy úprav provedete stejně
jako u vrstev, viz kapitola 4.2.3.

Vrstvy úprav vyvoláte v menu programu Layers > New Adjustment La-
yer [6] nebo kliknutím na 2. tlačítko zleva v menu dialogového okna Layers New
Adjustment Layer , v nabídce vyberte požadovanou vrstvu úprav.

4.2.5 Úkol č. 2

V tomto úkolu prozkoumejte barevné složky H, S, B u obrázku. Použijte vrstvu
úprav Odstín a sytost, měňte parametry, pozorujte změnu obrázku, pochopte prin-
cip vrstev úprav. V elearningu předmětu v sekci Reprezentace obrazu v počítači
klikněte na odkaz Úkol č. 2. Po otevření stránky uložte obrázek do počítače. Ob-
rázek otevřete podle postupu uvedeného v kapitole 4.2.2.

Vrstva úprav Odstín a sytost
Vrstvu úprav Odstín a sytost vyvoláte v menu programu Layers > New Adjust-
ment Layer > Hue/Saturation/Lightness... [6], zobrazí se dialogové okno,
viz obr. 4.18. V pravém horním rohu dialogového okna zvolte možnost Preview on
Image, změňte hodnotu u posuvníku Hue: a pozorujte změnu v obrázku. Změníte-li
hodnotu u posuvníku Saturation: na minimum, převedete obrázek na stupně šedi.
Po nastavení parametrů klikněte na tlačítko OK . Vrstvu úprav můžete vypnout
kliknutím na oko u vrstvy, k úpravě se můžete vrátit dvojklikem na vrstvu, zobrazí
se dialogové okno.
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4.2.6 Úkol č. 3

V tomto úkolu převeďte obrázek na stupně šedi různými způsoby. V elearningu
předmětu v sekci Reprezentace obrazu v počítači klikněte na odkaz Úkol č. 3.
Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu
uvedeného v kapitole 4.2.2.

Převedení obrazu na stupně šedi
Převedení obrazu na stupně šedi provedete v menu programu Image > Greyscale.
Pro vrácení převodu použijte klávesovou zkratku Ctrl + Z .

Vrstva úprav Odstín a sytost
Vrstvu úprav Odstín a sytost vyvoláte v menu programu Layers > New Ad-
justment Layer > Hue/Saturation/Lightness..., zobrazí se dialogové okno,
viz obr. 4.18. Změňte hodnotu u posuvníku Saturation: na minimum a klikněte na
tlačítko OK .

Nástroj Míchání kanálů
Nástroj Míchání kanálů vyvoláte v menu programu Adjust > Color > Channel
Mixer..., zobrazí se dialogové okno, viz obr. 4.21. V pravém horním rohu dialo-
gového okna zvolte možnost Preview on Image [3], vyzkoušejte měnit hodnoty
u jednotlivých posuvníků, pozorujte změnu obrazu. Součet hodnot u posuvníků by
měl být 100 %. Když bude součet méně, dojde k ztmavení obrazu, když bude součet
více, dojde k zesvětlení.

Obr. 4.21: Dialogové okno Channel Mixer.
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Nástroj Černá a bílá
Nástroj Černá a bílá vyvoláte v menu programu Effects > Photo Effects >
Black and White Film... [7], zobrazí se dialogové okno, viz obr. 4.22. Vyzkoušejte
měnit hodnoty u jednotlivých posuvníků, pozorujte změnu obrazu.

Obr. 4.22: Dialogové okno Black And White Film.

4.2.7 Nástroj Kapátko, nastavení velikosti vzorku

Nástroj Kapátko slouží k nabrání barvy. Výběr nástroje provedete v panelu nástrojů,
kliknutím na 4. nástroj odshora, Dropper Tool nebo použitím klávesové zkratky E.
Kliknutím do obrázku se do barvy popředí načte vybraná barva.

Změnu velikosti, z jak velké plochy se má barva vybrat a zprůměrovat, provedete
v dialogu Volby nástroje u možnosti Sample size:, viz obr. 4.17.

4.2.8 Úkol č. 1 – teplota chromatičnosti a vyvážení bílé

V tomto úkolu se dozvíte, jak kompenzovat vyvážení bílé pomocí vrstev úprav
Úrovně. V elearningu předmětu v sekci Reprezentace obrazu v počítači klik-
něte v části Teplota chromatičnosti a vyvážení bílé na odkaz Úkol č. 1. Po
otevření stránky uložte obrázky do počítače. Horní obrázek otevřete podle postupu
uvedeného v kapitole 4.2.2.

Korekce vyvážení bílé pomocí nástroje Úrovně
Vrstvu úprav Úrovně vyvoláte v menu programu Layers > New Adjustment
Layer > Levels..., zobrazí se dialogové okno. V okně zvolte šedé kapátko, které je
na obr. 4.23 v červeném kruhu [2]. V okně Before: vyberte na obrázku místo, které
by mělo být šedé a klikněte na něj. Program přepočítá obrázek tak, aby místo kam
kliknete bylo šedé. Jako vzor pro kompenzaci použijte spodní obrázek.
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Obr. 4.23: Dialogové okno Levels.

4.2.9 Úkol č. 2 – teplota chromatičnosti a vyvážení bílé

V tomto úkolu neutralizujte barevný nádech obrázku pomocí vrstvy s doplňkovou
barvou. V elearningu předmětu v sekci Reprezentace obrazu v počítači klikněte
v části Teplota chromatičnosti a vyvážení bílé na odkaz Úkol č. 2 – složitější,
pro zájemce. Po otevření stránky uložte obrázek do počítače. Obrázek otevřete
podle postupu uvedeného v kapitole 4.2.2.

V obrázku vyberte nástrojem Kapátko místo, které by mohlo být ve skutečnosti
neutrálně šedé. Zvolte nástroj podle postupu uvedeného v kapitole 4.2.7 a klikněte na
místo v obrázku. Vytvořte novou vrstvu podle postupu uvedeného v kapitole 4.2.3,
zvolte nástroj Flood Fill Tool kliknutím na 12. nástroj odshora v panelu nástrojů
nebo použitím klávesové zkratky F a kliknutím na vrstvu vyplňte vrstvu vybra-
nou barvou. Pro vytvoření vrstvy s doplňkovou barvou zvolte v menu programu
Image > Negative Image [3].

Nastavte režim prolnutí vrstvy na barva. Změnu režimu prolnutí vrstvy prove-
dete podle postupu uvedeného v kapitole 4.2.3, zvolte režim Color . Upravte krytí
vrstvy tak, aby byl obrázek neutrální. Změnu krytí vrstvy provedete podle postupu
uvedeného v kapitole 4.2.3. Zkontrolujte, zda zvolené místo je neutrální, zamyslete
se nad tím.
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4.2.10 Úkol č. 3 – teplota chromatičnosti a vyvážení bílé

V tomto úkolu neutralizujte barevný nádech obrázku pomocí barevného terčíku
z druhého obrázku. V elearningu předmětu v sekci Reprezentace obrazu v po-
čítači klikněte v části Teplota chromatičnosti a vyvážení bílé na odkaz
Úkol č. 3. Po otevření stránky uložte obrázky do počítače. Obrázky otevřete podle
postupu uvedeného v kapitole 4.2.2. Zvolte okno, ve kterém je obrázek s barevným
terčíkem. Zkopírujte obrázek, v menu programu zvolte Edit > Copy... nebo kláve-
sovou zkratku Ctrl + C . Zvolte okno, ve kterém je obrázek bez barevného terčíku.
Vložte obrázek, v menu programu zvolte Edit > Paste As New Layer nebo
klávesovou zkratku Ctrl + V .

Korekce vyvážení bílé pomocí vrstvy úprav Úrovně
Vrstvu úprav Úrovně vyvoláte v menu programu Layers > New Adjustment
Layer > Levels..., zobrazí se dialogové okno. V okně zvolte šedé kapátko, které
je na obr. 4.23 v červeném kruhu [2]. V okně Before: klikněte šedým kapátkem
na čtverečky ve spodním řádku barevného terčíku, pozorujte změny v obrázku. Po
úpravě vyvážení bílé zneviditelněte vrchní vrstvu s barevným terčíkem kliknutím na
oko u vrstvy.

Prozkoumání barevných složek L, a, b
Prozkoumejte barevné složky L, a, b čtverečků ve spodním řádku barevného terčíku.
Postupujte podle postupu uvedeného v kapitole 4.2.2. V dialogu Volby nástroje
zvolte u možnosti Color profile: možnost LAB, viz obr. 4.17. Jaké hodnoty barev-
ných složek by měly mít čtverečky s odstíny šedi? Jaké hodnoty jste zjistili?

4.2.11 Maska vrstvy

Maska vrstvy určuje viditelnost vrstvy, je to nedestruktivní úprava obrazu [8]. Pokud
je maska bílá, má funkci úplného krytí, vrstva je viditelná. Pokud je maska černá, má
funkci úplné průhlednosti, vrstva je průhledná. Stupně šedi značí postupný přechod
mezi úplným krytím a průhledností.

Vytvoření masky
Vytvoření masky vrstvy s úplným krytím provedete v menu programu Layers >
New Mask Layer > Show All nebo v menu dialogového okna Layers, kliknutím
na 3. tlačítko zleva New Mask Layer a zvolením možnosti Show All [3]. Maska
se přidá do vrstvy, viz obr. 4.24. Masku vypnete kliknutím na oko u masky vrstvy.

Změna výplně masky
Změnu výplně masky provedete kliknutím na masku vrstvy a použitím nástroje
Štětec. Výběr nástroje provedete v panelu nástrojů, kliknutím na 9. nástroj, Paint
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Obr. 4.24: Vrstva s maskou.

Brush nebo použijte klávesovou zkratku B. Nastavte barvu popředí na černou nebo
stupně šedi a kreslete do obrázku.

Odstranění masky
Odstranění masky vrstvy provedete kliknutím pravého tlačítka na masku a zvolením
možnosti Delete nebo v menu dialogového okna Layers kliknutím na 1. tlačítko
zprava Delete Layer [2].

4.2.12 Kontrolní otázky

1. Co je to nedestruktivní úprava?
2. Jakými způsoby můžete obraz převést na stupně šedi?
3. Co znamená vyvážení bílé?
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5 Návody k 3. počítačovému cvičení

5.1 GIMP – Počítačové formáty obrazu
Cíl
Cílem cvičení je seznámit se s formáty bitmapové grafiky. Porovnat závislost velikosti
a kvality obrazu u různých formátů. Určit vhodnost formátů pro různé typy obrazu.
Pochopit principy kódování u různých formátů.

5.1.1 Export for Web

Instalace pluginu Export for Web
Plugin stáhněte z odkazu http://www.mediafire.com/file/n6p0ayefix2tn8c/
gimp_169.zip/file, stažený soubor rozbalte a obsah archivu ZIP webexport.exe
vložte do složky C:\Users\"User"\AppData\Roaming\GIMP\2.10\plug-ins [1],
"User"změňte na vaše uživatelské jméno na počítači. Jestliže v průzkumníku souborů
nevidíte složku AppData, v horní části průzkumníku klikněte na záložku Zobra-
zení , ve které zvolte možnost Skryté položky [2]. Po vložení pluginu restartujte
program.

Export for Web dialog
Otevření dialogového okna Export for Web provedete v menu programu Soubor >
Export for Web..., zobrazí se dialogové okno, viz obr. 5.1. V levém horním rohu
dialogového okna můžete volit mezi různými druhy formátů – JPEG, PNG8, PNG24,
GIF.

Obr. 5.1: Dialogové okno Export for Web.
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Pod volbou formátů můžete přepínat mezi dvěma okny. První okno je určeno
k nastavení parametrů kompresních formátů. U formátu JPEG můžete nastavit
např. kvalitu, vyhlazení a volbu kódování – progresivní nebo optimalizované. U for-
mátu GIF můžete nastavit např. počet barev v paletě, volbu rozptýlení chyby.
U formátu PNG8 můžete nastavit např. počet barev v paletě, volbu rozptýlení
chyby, úroveň komprese [1]. U formátu PNG24 můžete nastavit úroveň komprese.
V druhém okně můžete měnit rozměry bitmapy. Výsledný obrázek po nastavení pa-
rametrů kompresních formátů můžete vidět v náhledovém okně. V pravém dolním
rohu dialogového okna můžete měnit zvětšení náhledu. Přiblížit a oddálit náhled
můžete i stisknutím levé klávesy Ctrl a rolováním kolečka myši.

Po nastavení parametrů klikněte na tlačítko Export, zobrazí se dialogové okno
s adresářem souborů, viz obr. 5.2. V okně zvolte název souboru, umístění a klikněte
na tlačítko Export.

Obr. 5.2: Dialogové okno Export for Web adresář souborů.

5.1.2 JPEG 2000

Instalace pluginu pro JPEG 2000
Plugin stáhněte z odkazu http://advance-software.com/download/tools/gimp/,
stažený soubor jp2.exe vložte do složky C:\Users\"User"\AppData\Roaming\
GIMP\2.10\plug-ins, "User"změňte na vaše uživatelské jméno na počítači [3]. Po
vložení pluginu restartujte program.

Otevření souboru ve formátu JPEG 2000
Otevření souboru z počítače provedete v menu programu Soubor > Otevřít...,
klávesovou zkratkou Ctrl + O nebo dvojklikem na pracovní plochu bez vytvořeného
plátna, zobrazí se dialogové okno s adresářem souborů, viz obr. 5.3. V dialogovém
okně rozbalte nabídku Zvolte typ souboru, v této nabídce zvolte typ souboru
Obrázek JPEG 2000 , případně J2K image, vyberte soubor z adresáře souborů
a klikněte na tlačítko Otevřít [4].
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Obr. 5.3: Dialogové okno pro otevření.

Uložení souboru do formátu JPEG 2000
Uložení do tohoto formátu provedete v menu programu Soubor > Export As...
nebo klávesovou zkratkou Shift + Ctrl + E [5], zobrazí se dialogové okno s ad-
resářem souborů, viz obr. 5.4. V dialogovém okně rozbalte nabídku Zvolte typ
souboru, v této nabídce zvolte typ souboru JPEG-2000 image, v průzkumníku
souborů zvolte umístění a název souboru.

Obr. 5.4: Dialogové okno pro uložení.

Po kliknutí na tlačítko Exportovat se spustí plugin a zobrazí se dialogové okno
s možností nastavení kvality souboru, viz obr. 5.5. V dialogovém okně je zobrazena
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velikost výsledného souboru. Náhled výsledného obrázku je zobrazen v pracovní
ploše. Po nastavení kvality klikněte na tlačítko Uložit.

Obr. 5.5: Dialogové okno pro nastavení kvality JPEG 2000.

5.1.3 Úkol č. 1

V tomto úkolu uložte několik obrázků do různých formátů, porovnejte kvalitu a ve-
likost souborů. Určete, který formát je vhodný pro jaký druh obrázku.

V elearningu předmětu v sekci Počítačové formáty obrazů klikněte na odkaz
Úkol č. 1. Po otevření stránky klikněte na odkaz následující obrázky a klikněte
na tlačítko Stáhnout složku. V počítači vytvořte složku, ve které rozbalte stažený
ZIP archiv. V archivu je 5 bitmapových souborů ve formátech: BMP, GIF, JPEG,
JPEG 2000 a PNG. Jednotlivé bitmapy zkuste uložit ve formátech: BMP, GIF,
JPEG, JPEG 2000, PNG8, PNG24, TIFF. Porovnejte kvalitu a velikosti souborů.

Otevření souboru
Otevření souboru z počítače provedete v menu programu Soubor > Otevřít...,
klávesovou zkratkou Ctrl + O nebo dvojklikem na pracovní plochu bez vytvořeného
plátna, zobrazí se dialogové okno s adresářem souborů, viz obr. 5.6. Vyberte soubor
z adresáře souborů a klikněte na tlačítko Otevřít [4].

Obr. 5.6: Dialogové okno pro otevření.
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Uložení souboru do různých formátů
U formátů podporovaných v rámci dialogu Export for Web (JPEG, GIF, PNG8,
PNG24) využijte tohoto dialogu k uložení bitmapy a postupujte podle postupu uve-
deného v kapitole 5.1.1, soubor pojmenujte stejně jako je název výchozího souboru.

Pro uložení bitmapy do formátu JPEG 2000 postupujte podle postupu uvede-
ného v kapitole 5.1.2, soubor pojmenujte stejně jako je název výchozího souboru.
V případě neúspěšného uložení zkuste zvolit jinou složku v počítači.

Pro uložení souboru do formátů BMP a TIFF zvolte v menu programu Sou-
bor > Export As... nebo klávesovou zkratku Shift + Ctrl + E, zobrazí se dia-
logové okno s adresářem souborů, viz obr. 5.7. V dialogovém okně rozbalte nabídku
Zvolte typ souboru a vyberte požadovaný formát souboru. V adresáři souborů
zvolte složku, kterou jste vytvořili dříve. Soubor pojmenujte stejně jako je název
výchozího souboru a klikněte na tlačítko Exportovat. Při zvoleném formátu BMP
se zobrazí dialogové okno, ve kterém můžete nastavit barevnou hloubku obrazu, viz
obr. 5.8. Při zvoleném formátu TIFF se zobrazí dialogové okno, ve kterém můžete
nastavit volbu komprimace, viz obr. 5.9. Pro uložení souboru klikněte na tlačítko
Exportovat.

Vyzkoušejte různé nastavení pro jednotlivé formáty. Porovnejte vizuální kvalitu
obrazu a velikosti souborů pro různé druhy obrázků a formátů. Určete a zdůvodněte,
který formát je vhodný pro jaký druh obrázku.

Obr. 5.7: Dialogové okno pro export obrázku.
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Obr. 5.8: Dialogové okno pro export formátu BMP.

Obr. 5.9: Dialogové okno pro export formátu TIFF.

5.1.4 Úkol č. 2

V tomto úkolu uložte obrázek do formátu JPEG, poté obrázek převeďte do stupňů
šedi a uložte jej do formátu JPEG se stejným nastavením kvality, jako barevný
obrázek. Porovnejte a zdůvodněte velikost obrázku barevného a ve stupních šedi.

V elearningu předmětu v sekci Počítačové formáty obrazů klikněte na odkaz
Úkol č. 2. Po otevření stránky uložte obrázek do složky vytvořené v předchozím
úkolu.

Otevření souboru
Otevření souboru z počítače provedete v menu programu Soubor > Otevřít...,
klávesovou zkratkou Ctrl + O, zobrazí se dialogové okno s adresářem souborů, viz
obr. 5.6. Ze složky vyberte obrázek nature-01.jpg a klikněte na tlačítko Otevřít [4].
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Uložení souboru
Pro uložení obrázku zvolte v menu programu Soubor > Export As... nebo kláve-
sovou zkratku Shift + Ctrl + E, zobrazí se dialogové okno s adresářem souborů,
viz obr. 5.7. V dialogovém okně rozbalte nabídku Zvolte typ souboru a vyberte
typ souboru Obrázek JPEG. V adresáři souborů zvolte složku, kterou jste vy-
tvořili dříve, soubor pojmenujte barevny.jpg a klikněte na tlačítko Exportovat.
Zobrazí se dialogové okno, ve kterém můžete nastavit kvalitu obrazu, viz obr. 5.10.
Po nastavení kvality klikněte na tlačítko Exportovat.

Obr. 5.10: Dialogové okno pro export formátu JPEG.

Převedení obrazu do stupňů šedi
Převedení obrazu do stupňů šedi provedete v menu programu Obrázek > Režim >
Odstíny šedi [4]. Obrázek ve stupních šedi uložte do složky podle postupu uvede-
ného výše, použijte stejné nastavení kvality a soubor pojmenujte sedotonovy.jpg.
Porovnejte velikost souboru barevného a obrázku ve stupních šedi, zdůvodněte rozdíl
velikostí souborů.

5.1.5 Kontrolní otázky

1. Co znamená barevná paleta? Jaké formáty souboru ji používají?
2. Formát souboru PNG je vhodný pro uložení jakého typu obrazu?
3. Proč v úkolu č. 2 není výrazný rozdíl ve velikosti monochromatického a barev-

ného obrázku?
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5.2 Corel PaintShop Pro 2022 – Počítačové formáty
obrazu

Cíl
Cílem cvičení je seznámit se s formáty bitmapové grafiky. Porovnat závislost velikosti
a kvality obrazu u různých formátů. Určit vhodnost formátů pro různé typy obrazu.
Pochopit principy kódování u různých formátů.

5.2.1 Export s náhledem kvality

Otevření dialogového okna pro export s náhledem kvality pro formát JPEG prove-
dete v menu programu File > Export > JPEG Optimizer..., pro formát GIF
provedete v menu programu File > Export > GIF Optimizer..., pro formát
PNG provedete v menu programu File > Export > PNG Optimizer..., zobrazí
se dialogové okno [1], viz obr. 5.11.

Obr. 5.11: Dialogové okno export s náhledem kvality PNG.

V horní části dialogového okna je náhledové okno s výsledným obrázkem po
nastavení parametrů kompresního formátu. Pod náhledovým oknem je u možností
Uncompressed: a Compressed: zobrazena velikost originálního a komprimova-
ného obrázku.

1



Pod velikostmi souborů můžete přepínat mezi okny. U formátu JPEG můžete
v jednotlivých oknech nastavit např. míru komprese, volbu kódování – progresivní
nebo standardní. U formátu GIF můžete nastavit např. barevnou paletu, počet
barev v paletě, míru rozptýlení chyby [2]. U formátu PNG můžete nastavit např.
barevnou paletu, počet barev v paletě, míru rozptýlení chyby. Pro volbu formátu
PNG8 zvolte v okně Colors možnost Palette-Based. Pro volbu formátu PNG24
zvolte v okně Colors možnost 16.7 Million Colors (24 Bit) [3].

Po nastavení parametrů klikněte na tlačítko OK , zobrazí se dialogové okno s ad-
resářem souborů. V okně zvolte název souboru, umístění a klikněte na tlačítko Ulo-
žit.

5.2.2 JPEG 2000

Otevření souboru ve formátu JPEG 2000
Otevření souboru z počítače provedete v menu programu File > Open..., kláve-
sovou zkratkou Ctrl + O nebo kliknutím na 1. tlačítko v panelu funkcí, zobrazí se
dialogové okno s adresářem souborů, viz obr. 5.12. V dialogovém okně rozbalte na-
bídku All Files, v této nabídce zvolte typ souboru JP2 JPEG 2000 [4], vyberte
soubor z adresáře souborů a klikněte na tlačítko Otevřít.

Obr. 5.12: Dialogové okno pro otevření.

Uložení souboru do formátu JPEG 2000
Uložení do tohoto formátu provedete v menu programu File > Save As..., klá-
vesovou zkratkou F12 nebo kliknutím na šesté tlačítko v panelu funkcí, zobrazí
se dialogové okno s adresářem souborů, viz obr. 5.13. V dialogovém okně rozbalte
nabídku Uložit jako typ: v této nabídce zvolte typ souboru JP2 JPEG 2000 ,
v průzkumníku souborů zvolte umístění, název souboru a klikněte na tlačítko Ulo-
žit.
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Obr. 5.13: Dialogové okno pro uložení.

5.2.3 Úkol č. 1

V tomto úkolu uložte několik obrázků do různých formátů, porovnejte kvalitu a ve-
likost souborů. Určete, který formát je vhodný pro jaký druh obrázku.

V elearningu předmětu v sekci Počítačové formáty obrazů klikněte na odkaz
Úkol č. 1. Po otevření stránky klikněte na odkaz následující obrázky a klikněte
na tlačítko Stáhnout složku. V počítači vytvořte složku, ve které rozbalte stažený
ZIP archiv. V archivu je 5 bitmapových souborů ve formátech: BMP, GIF, JPEG,
JPEG 2000 a PNG. Jednotlivé bitmapy zkuste uložit ve formátech: BMP, GIF,
JPEG, JPEG 2000, PNG8, PNG24, TIFF. Porovnejte kvalitu a velikosti souborů.

Otevření souboru
Otevření souboru z počítače provedete v menu programu File > Open..., kláve-
sovou zkratkou Ctrl + O nebo kliknutím na 3. tlačítko v panelu funkcí, zobrazí
se dialogové okno s adresářem souborů, viz obr. 5.12. Vyberte soubor z adresáře
souborů a klikněte na tlačítko Otevřít [1].

Uložení souboru do různých formátů
U formátů podporovaných s náhledem kvality (JPEG, GIF, PNG8, PNG24) využijte
tohoto dialogu k uložení bitmapy a postupujte podle postupu uvedeného v kapitole
5.2.1, soubor pojmenujte stejně jako je název výchozího souboru.

Pro uložení bitmapy do formátu JPEG 2000 postupujte podle postupu uvedeného
v kapitole 5.2.2, soubor pojmenujte stejně jako je název výchozího souboru.
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Pro uložení souboru do formátů BMP a TIFF zvolte v menu programu File >
Save As... nebo klávesovou zkratku F12 , zobrazí se dialogové okno s adresá-
řem souborů, viz obr. 5.13. V dialogovém okně rozbalte nabídku Uložit jako typ:
a vyberte požadovaný formát souboru. V adresáři souborů zvolte složku, kterou jste
vytvořili dříve. Soubor pojmenujte stejně jako je název výchozího souboru a klikněte
na tlačítko Uložit.

Při zvoleném formátu BMP klikněte na tlačítko Options... [5], zobrazí se dialo-
gové okno, ve kterém můžete nastavit parametry formátu, viz obr. 5.14. Při zvoleném
formátu TIFF klikněte na tlačítko Options..., zobrazí se dialogové okno, ve kterém
můžete nastavit parametry formátu, viz obr. 5.15.

Vyzkoušejte různé nastavení pro jednotlivé formáty. Porovnejte vizuální kvalitu
obrazu a velikosti souborů pro různé druhy obrázků a formátů. Určete a zdůvodněte,
který formát je vhodný pro jaký druh obrázku.

Obr. 5.14: Dialogové okno pro nastavení formátu BMP.

Obr. 5.15: Dialogové okno pro nastavení formátu TIFF.
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5.2.4 Úkol č. 2

V tomto úkolu uložte obrázek ve formátu JPEG, poté obrázek převeďte do stupňů
šedi a uložte jej do formátu JPEG se stejným nastavením kvality, jako barevný
obrázek. Porovnejte a zdůvodněte velikost obrázku barevného a ve stupních šedi.

V elearningu předmětu v sekci Počítačové formáty obrazů klikněte na odkaz
Úkol č. 2. Po otevření stránky uložte obrázek do složky vytvořené v předchozím
úkolu.

Otevření souboru
Otevření souboru z počítače provedete v menu programu File > Open... [6], klá-
vesovou zkratkou Ctrl + O nebo kliknutím na 3. tlačítko v panelu funkcí, zobrazí
se dialogové okno s adresářem souborů, viz obr. 5.12. Ze složky vyberte obrázek
nature-01.jpg a klikněte na tlačítko Otevřít.

Uložení souboru
Uložení obrázku provedete v menu programu File > Save As..., klávesovou zkrat-
kou F12 nebo kliknutím na šesté tlačítko v panelu funkcí, zobrazí se dialogové okno
s adresářem souborů, viz obr. 5.13. V dialogovém okně rozbalte nabídku Uložit jako
typ: a vyberte typ souboru JPG JPEG. U posuvníku Compression: nastavte
kvalitu. V adresáři souborů zvolte složku, kterou jste vytvořili dříve, soubor pojme-
nujte barevny.jpg a klikněte na tlačítko Uložit.

Převedení obrazu do stupňů šedi
Převedení obrazu do stupňů šedi provedete v menu programu Image > Greyscale.
Obrázek ve stupních šedi uložte do složky podle postupu uvedeného výše, použijte
stejné nastavení kvality a soubor pojmenujte sedotonovy.jpg. Porovnejte velikost
souboru barevného a obrázku ve stupních šedi, zdůvodněte rozdíl velikostí souborů.

5.2.5 Kontrolní otázky

1. Co znamená barevná paleta? Jaké formáty souboru ji používají?
2. Formát souboru PNG je vhodný pro uložení jakého typu obrazu?
3. Proč v úkolu č. 2 není výrazný rozdíl ve velikosti monochromatického a barev-

ného obrázku?
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6 Návody k 4. počítačovému cvičení

6.1 GIMP – Úpravy bitmapových obrazů
Cíl
Cvičení se zabývá úpravami bitmapových obrazů. Obsahem cvičení je: seznámení
se s histogramem, používání nástrojů k úpravě podexponované fotografie, princip
nedestruktivní úpravy, převedení obrázku do indexované barvy, aplikace lineárních
filtrů na obrázek, změna rozlišení a velikosti obrázku, volba interpolačního jádra při
převzorkování.

6.1.1 Histogram

V tomto úkolu se dozvíte, co je to a jak používat histogram. V elearningu předmětu
v sekci Úpravy bitmapových obrazů klikněte na odkaz Obrázek pro zkoušení
histogramu. Po otevření stránky uložte obrázek do počítače. Seznamte se s oknem
Histogram, vyzkoušejte různé nastavení.

Otevření souboru
Otevření souboru z počítače provedete v menu programu Soubor > Otevřít...,
klávesovou zkratkou Ctrl + O nebo dvojklikem na pracovní plochu bez vytvořeného
plátna, zobrazí se dialogové okno s adresářem souborů, viz obr. 6.1. Vyberte stažený
soubor z adresáře souborů a klikněte na tlačítko Otevřít [1].

Obr. 6.1: Dialogové okno pro otevření.

Dialogové okno Histogram
Dialogové okno Histogram vyvoláte v menu programu Okna > Dokovatelná di-
alogová okna > Histogram. Histogram se zobrazí v pravé horní části programu,
viz obr. 6.2. Na histogramu je znázorněno na horizontální ose od černé do bílé (od
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0 do 255), uvažujeme-li histogram pro jas, jak četně jsou zastoupeny jednotlivé ba-
revné složky v obrázku [2].

V levém horním rohu dialogového okna můžete přepínat kanály: jasový, červený,
zelený, modrý a RGB. V pravém horním rohu dialogového okna můžete měnit mezi
zobrazením hodnot v lineárním a perceptuálním prostoru a přepínat mezi lineárním
a logaritmickým histogramem.

Obr. 6.2: Dialogové okno Histogram.

6.1.2 Úkol – podexponovaná fotografie

V tomto úkolu upravte podexponovanou fotografii. Vyzkoušejte různé úpravy, během
kterých pozorujte změny v histogramu. V elearningu předmětu v sekci Úpravy
bitmapových obrazů klikněte na odkaz Úkol – podexponovaná fotografie.
Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu
uvedeného v kapitole 6.1.1.

Jas a kontrast
Nástroj Jas a kontrast vyvoláte v menu programu Barvy > Jas-kontrast...,
zobrazí se dialogové okno, viz obr. 6.3. Vyzkoušejte měnit hodnoty u posuvníků Jas
a Kontrast, pozorujte změnu obrázku a změnu histogramu.

Úrovně
Nástroj Úrovně vyvoláte v menu programu Barvy > Úrovně..., zobrazí se dialo-
gové okno, viz obr. 6.4. Levý (černý) jezdec u vstupní úrovně slouží k určení barvy,
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Obr. 6.3: Dialogové okno Jas-kontrast.

kterou chcete mapovat na nejtmavší barvu v obrázku, můžete použít i kapátko.
Prostřední jezdec slouží ke gama korekci. Pravý (bílý) jezdec slouží k určení barvy,
kterou chcete mapovat na nejsvětlejší barvu v obrázku, můžete použít i kapátko [3].
Jezdce u výstupních úrovní umožňují zvolit rozsah výstupních úrovní obrázku. Vy-
zkoušejte měnit pozici jezdců u vstupní a výstupní úrovně, pozorujte změnu obrázku
a změnu histogramu.

Obr. 6.4: Dialogové okno Úrovně.

Křivky
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Souvislost Křivky a Úrovně, na stránce je na obrázku graficky znázorněna
souvislost mezi nástroji Křivky a Úrovně.

Nástroj Křivky vyvoláte v menu programu Barvy > Křivky..., zobrazí se
dialogové okno, viz obr. 6.5. Horizontální osa u grafu znázorňuje vstupní hodnoty,
vertikální osa znázorňuje výstupní hodnoty [4]. Body na křivku přidáte kliknutím na
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křivku. U jednotlivých bodů na křivce můžete pod grafem křivky u možností Input:
a Output: nastavit hodnoty k přemapování vstupní hodnoty na výstupní. Nástroj
Křivky je ve srovnání s nástroji Jas a kontrast a Úrovně nejsložitější, umožňuje
nelineární převodní charakteristiku. Vyzkoušejte měnit tvar křivky, pozorujte změnu
obrázku a změnu histogramu.

Obr. 6.5: Dialogové okno Křivky.

Stíny a světla
Nástroj Stíny a světla vyvoláte v menu programu Barvy > Stíny-Světla..., zob-
razí se dialogové okno, viz obr. 6.6. Vyzkoušejte měnit hodnotu u posuvníku Sha-
dows, pozorujte změnu obrázku a změnu histogramu.

Obr. 6.6: Dialogové okno Stíny a světla.
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6.1.3 Úkol – lokální a nedestruktivní úprava jasu v obrazu

V tomto úkolu se dozvíte, jak upravit jas části obrazu nedestruktivní úpravou.
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Úkol – lokální a nedestruktivní úprava jasu v obrazu. Po otevření
stránky uložte obrázek do počítače. Obrázek otevřete podle postupu uvedeného
v kapitole 6.1.1. Pro nedestruktivní úpravu vytvořte vrstvu obsahující 50% šedou
barvu, nastavte režim krytí na překrýt a aplikujte na ni nástroje Zesvětlit a Ztmavit.
Vyzkoušejte různé nastavení nástroje a ztmavte stromy v pozadí.

Vytvoření vrstvy s 50% šedou barvu
Vyberte 50% šedou barvu v dialogu Změna barvy popředí v panelu nástrojů,
viz obr. 6.7. Vytvoření nové vrstvy provedete v menu programu Vrstva > Nová
vrstva..., klávesovou zkratkou Shift + Ctrl + N nebo v pravé dolní části pro-
gramu, v menu dialogového okna Vrstvy, kliknutím na 1. tlačítko zleva Vytvořit no-
vou vrstvu a přidat ji do obrázku. Zobrazí se dialogové okno Nová vrstva [5],
u možnosti Režim: zvolte Překrýt, u možnosti Vyplnit s: zvolte Foreground
color a klikněte na tlačítko OK .

Obr. 6.7: Dialogové okno Změna barvy popředí.

Nástroje Zesvětlit a Ztmavit
Výběr nástrojů Zesvětlit a Ztmavit provedete v panelu nástrojů. Klikněte pravým
tlačítkem na 5. nástroj v 2. řádku, nástroj Rozmazat a vyberte nástroj Zesvětlení/
ztmavení nebo použijte klávesovou zkratku Shift + D. Pod panelem nástrojů v di-
alogu Volby nástroje nastavte parametry nástroje, jako jsou např. velikost, tvrdost,
síla, rozsah tónů. Při podržení klávesy Ctrl přepnete nástroj z režimu zesvětlení do
režimu ztmavení. Vyzkoušejte různé nastavení nástroje a ztmavte stromy v pozadí.
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6.1.4 Úkol – převod obrázku do palety

V tomto úkolu převeďte obrázek z RGB do barevné palety. V elearningu předmětu
v sekci Úpravy bitmapových obrazů klikněte na odkaz Úkol – převod obrázku
do palety. Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle
postupu uvedeného v kapitole 6.1.1.

Převod do barevné palety
Převedení obrázku do barevné palety provedete v menu programu Obrázek > Re-
žim > Indexovaný..., zobrazí se dialogové okno, viz obr. 6.8. U možnosti Mapa
barev zvolte z několika možností barev v paletě. U možnosti Rozptyl vyberte
z několika možností rozptylování barev. Po nastavení parametrů klikněte na tlačítko
Převést. Pro vrácení převodu použijte klávesovou zkratku Ctrl + Z , vyzkoušejte
různé nastavení převodu.

Obr. 6.8: Dialogové okno pro nastavení převodu barev na indexované.

6.1.5 Úkol – uložení snímku obrazovky v paletovém režimu, vy-
nucené barvy

V tomto úkolu převeďte obrázek z RGB do barevné palety pomocí dialogu Export
for Web. V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte
na odkaz Úkol – uložení snímku obrazovky v paletovém režimu, vynucené
barvy. Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle
postupu uvedeného v kapitole 6.1.1. Obrázek převeďte z RGB do barevné palety
pomocí dialogu Export for Web. Při jakém počtu barev a při jakém algoritmu tvorby
palety dosáhnete nejlepších výsledků?
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Instalace pluginu Export for Web
Plugin stáhněte z odkazu http://www.mediafire.com/file/n6p0ayefix2tn8c/
gimp_169.zip/file, stažený soubor rozbalte a obsah archivu ZIP webexport.exe
vložte do složky C:\Users\"User"\AppData\Roaming\GIMP\2.10\plug-ins [6],
"User"změňte na vaše uživatelské jméno na počítači. Po vložení pluginu restartujte
program.

Export for Web dialog
Otevření dialogového okna Export for Web provedete v menu programu Soubor >
Export for Web..., zobrazí se dialogové okno, viz obr. 6.9. V levém horním rohu
dialogového okna zvolte formát, barevnou paletu používají formáty PNG-8 a GIF.
Pod volbou formátů je okno, ve kterém nastavte parametry formátu. Zvolte z ně-
kolika možností barevných palet, u možnosti Dither: vyberte z několika možností
rozptylování barev [6]. Náhled výsledného obrázku je zobrazen v náhledovém okně.

Po nastavení parametrů klikněte na tlačítko Export, zobrazí se dialogové okno
s adresářem souborů. V okně zvolte název souboru, umístění a klikněte na tlačítko
Export.

Obr. 6.9: Dialogové okno Export for Web.

6.1.6 Úkol – konvoluce obrázku s impulzní odezvou

V tomto úkolu aplikujte na obrázek několik lineárních filtrů – 2D Diracův impulz, po-
sunutý 2D Diracův impulz, dolní a horní propust. Vyzkoušejte různé varianty filtrů,
pozorujte změny obrázku. V elearningu předmětu v sekci Úpravy bitmapových
obrazů klikněte na odkaz Úkol – konvoluce obrázku s impulzní odezvou.
Po otevření stránky uložte obrázek s autem do počítače. Obrázek otevřete podle
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postupu uvedeného v kapitole 6.1.1. Otevření dialogového okna Konvoluční ma-
tice provedete v menu programu Filtry > Obecné > Konvoluční matice... [7],
zobrazí se dialogové okno, viz obr. 6.10.

2D Diracův impuls
Jednotkový Diracův impuls neudělá žádnou změnu v obrázku. Pro aplikaci filtru
vyplňte hodnoty konvoluční matice, viz obr. 6.10.

Obr. 6.10: Konvoluční matice pro 2D Diracův impuls.

Posunutý 2D Diracův impuls
Pro aplikaci posunutého 2D Diracova impulsu změňte hodnotu středního pole z 1 na 0.
V jednom libovolném poli, kromě pole ve středu matice změňte hodnotu z 0 na 1.
Pozorujte změnu obrázku zapnutím a vypnutím možnosti Náhled.

Dolní propust
Filtr dolní propust odpovídá rozmazání. V okně vypněte možnost Normalize, sou-
čet hodnot v matici musí být stejný jako hodnota u možnosti Divisor. Pro aplikaci
filtru vyplňte hodnoty konvoluční matice, viz obr. 6.11.
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Obr. 6.11: Konvoluční matice pro dolní propust.

Horní propust
Filtr horní propust odpovídá zaostření, součet hodnot v matici musí být roven 0.
Pro aplikaci filtru vyplňte hodnoty konvoluční matice, viz obr. 6.12. V okně musí
být zapnutá možnost Normalize.

Obr. 6.12: Konvoluční matice pro horní propust.

Vytlačení (emboss)
Pro aplikaci filtru vytlačení vyplňte hodnoty konvoluční matice, viz obr. 6.13. V okně
musí být zapnutá možnost Normalize. Klikněte na tlačítko Otočit matici a po-
zorujte změny v obrázku.
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Obr. 6.13: Konvoluční matice pro filtr vytlačení.

6.1.7 Úkol – aplikace konvoluce při zostření snímku

V tomto úkolu doostřete obrázek buď pomocí filtru horní propust nebo filtru doost-
řit. V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Úkol – aplikace konvoluce při zostření snímku. Po otevření stránky uložte
obrázek do počítače. Obrázek otevřete podle postupu uvedeného v kapitole 6.1.1.

Doostření obrázku pomocí filtru horní propust
Duplikujte vrstvu obrázku v menu programu Vrstva > Duplikovat vrstvu, klá-
vesovou zkratkou Shift + Ctrl + D nebo kliknutím pravého tlačítka na vrstvu
a zvolením možnosti Duplikovat vrstvu. Na nově vytvořenou vrstvu aplikujte filtr
horní propust v menu programu Filtry > Vylepšit > Horní propust..., zobrazí
se dialogové okno, viz obr. 6.14. V okně vyzkoušejte různé nastavení parametrů. Po
nastavení parametrů klikněte na tlačítko OK .

Obr. 6.14: Dialogové okno filtru horní propust.

Změnu režimu prolnutí vrstvy na překrýt provedete rozbalením nabídky Režim
nad vrstvou a zvolením možnosti Překrýt nebo kliknutím pravého tlačítka na vrstvu
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a zvolením možnosti Upravit vlastnosti vrstvy..., otevře se dialogové okno, ve
kterém u možnosti Režim: zvolte Překrýt.

Doostření obrázku pomocí filtru doostřit (Unsharp Mask)
Na obrázek aplikujte filtr doostřit v menu programu Filtry > Vylepšit > Shar-
pen (Unsharp Mask)..., zobrazí se dialogové okno, viz obr. 6.15. V okně vyzkou-
šejte různé nastavení parametrů. Po nastavení parametrů klikněte na tlačítko OK .

Obr. 6.15: Dialogové okno filtru Sharpen.

6.1.8 Úkol – rozdíl mezi změnou velikosti a změnou rozlišení

V tomto úkolu pochopíte rozdíl mezi změnou rozlišení a změnou velikosti obrázku.
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Úkol – rozdíl mezi změnou velikosti a změnou rozlišení. Po otevření
stránky uložte obrázek do počítače. Obrázek otevřete podle postupu uvedeného
v kapitole 6.1.1. Změňte rozlišení obrázku na 300 ppi. Jaké velikosti obrázku v tisku
to odpovídá? Změňte velikost obrázku (proporcionálně) tak, aby jeho šířka byla
600 px. Jak velký bude obrázek na monitoru?

Změna rozlišení obrázku
Změnu rozlišení obrázku provedete v menu programu Obrázek > Škálovat ob-
rázek..., zobrazí se dialogové okno, viz obr. 6.16. U možnosti Rozlišení X: zvolte
hodnotu 300 pixelů/in a stiskněte klávesu Enter . Pro zjištění velikosti obrázku
v tisku zvolte u možnosti Velikost obrázku jednotku mm a odečtěte hodnoty. Po
nastavení parametrů klikněte na tlačítko Škálovat.

Změna velikosti obrázku
Změnu velikosti obrázku provedete v menu programu Obrázek > Škálovat obrá-
zek..., zobrazí se dialogové okno, viz obr. 6.16. U možnosti Šířka: zvolte hodnotu
600 px a stiskněte klávesu Enter . Pro zjištění velikosti obrázku zvolte u možnosti
Velikost obrázku jednotku mm a odečtěte hodnoty. Po nastavení parametrů klik-
něte na tlačítko Škálovat.
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Obr. 6.16: Dialogové okno pro změnu rozlišení a velikosti.

6.1.9 Úkol – volba interpolačního jádra při převzorkování

V tomto úkolu zmenšete obrázek, vyzkoušejte různé interpolační jádra a pozorujte
rozdíly v obrázku. V elearningu předmětu v sekci Úpravy bitmapových obrazů
klikněte na odkaz Úkol – volba interpolačního jádra při převzorkování. Po
otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu uve-
deného v kapitole 6.1.1. Obrázek zmenšete na 25 % původní velikosti a vyzkoušejte
různé volby interpolačního jádra. Která z nich dává nejpřijatelnější výsledky? Jaký
jev pozorujete u všech ostatních?

Převzorkování obrázku
Změnu velikosti obrázku a volbu interpolačního jádra provedete v menu programu
Obrázek > Škálovat obrázek..., zobrazí se dialogové okno, viz obr. 6.16. U mož-
nosti Velikost obrázku nastavte 25 % a u možnosti Interpolace: volte z nabíze-
ných možností. Možnost Žádná odpovídá metodě nejbližší soused, možnost Line-
ární odpovídá metodě bilineární, možnost Kubická odpovídá metodě bikubická,
možnost NoHalo nejspíše odpovídá metodě bikubická ostřejší, možnost LoHalo
nejspíše odpovídá metodě bikubická hladší [8]. Po nastavení parametrů klikněte na
tlačítko Škálovat.

6.1.10 Kontrolní otázky

1. Co je to histogram?
2. Co způsobí filtr typu dolní propust?
3. Jaký je rozdíl mezi změnou velikosti a změnou rozlišení obrazu?
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6.2 Corel PaintShop Pro 2022 – Úpravy bitmapových
obrazů

Cíl
Cvičení se zabývá úpravou bitmapových obrazů. Obsahem cvičení je: seznámení
se s histogramem, používání nástrojů k úpravě podexponované fotografie, princip
nedestruktivní úpravy, převedení obrázku do indexované barvy, aplikace lineárních
filtrů na obrázek, změna rozlišení a velikosti obrázku, volba interpolačního jádra při
převzorkování.

6.2.1 Histogram

V tomto úkolu se dozvíte co je to a jak používat histogram. V elearningu předmětu
v sekci Úpravy bitmapových obrazů klikněte na odkaz Obrázek pro zkoušení
histogramu. Po otevření stránky uložte obrázek do počítače. Seznamte se s oknem
Histogram, vyzkoušejte různé nastavení.

Otevření souboru
Otevření souboru z počítače provedete v menu programu File > Open..., kláve-
sovou zkratkou Ctrl + O nebo kliknutím na 3. tlačítko v panelu funkcí, zobrazí
se dialogové okno s adresářem souborů, viz obr. 6.17. Vyberte soubor z adresáře
souborů a klikněte na tlačítko Otevřít [1].

Obr. 6.17: Dialogové okno pro otevření.

Dialogové okno Histogram
Dialogové okno Histogram vyvoláte v menu programu Palettes > Histogram
nebo klávesovou zkratkou F7 . Histogram se zobrazí v pravé horní části programu,
viz obr. 6.18. Na histogramu je znázorněno na horizontální ose od černé do bílé
(od 0 do 255), uvažujeme-li histogram pro jas, jak četně jsou zastoupeny jednotlivé
barevné složky v obrázku [2].
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V dolním rohu dialogového okna můžete volit kanály: Red, Green, Blue, Greys-
cale, Hue, Saturation, Lightness. V pravém horním rohu dialogového okna můžete
u možnosti Display channel: měnit mezi zobrazením hodnot u jednotlivých kanálů.

Obr. 6.18: Dialogové okno Histogram.

6.2.2 Úkol – podexponovaná fotografie

V tomto úkolu upravte podexponovanou fotografii. Vyzkoušejte různé úpravy, během
kterých pozorujte změny v histogramu. V elearningu předmětu v sekci Úpravy
bitmapových obrazů klikněte na odkaz Úkol – podexponovaná fotografie.
Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu
uvedeného v kapitole 6.2.1.

Jas a kontrast
Vrstvu úprav Jas a kontrast vyvoláte v menu programu Layers > New Ad-
justment Layer > Brightness/Contrast... [3], zobrazí se dialogové okno, viz
obr. 6.19. Vyzkoušejte měnit hodnoty u posuvníků Brightness: a Contrast:. V pra-
vém horním rohu dialogového okna zvolte možnost Preview on Image, pozorujte
změnu obrázku a změnu histogramu.

Úrovně
Vrstvu úprav Úrovně vyvoláte v menu programu Layers > New Adjustment La-
yer > Levels..., zobrazí se dialogové okno, viz obr. 6.20. Levý (černý) jezdec slouží
k určení barvy, kterou chcete mapovat na nejtmavší barvu v obrázku. Prostřední
jezdec slouží ke gama korekci. Pravý (bílý) jezdec slouží k určení barvy, kterou chcete
mapovat na nejsvětlejší barvu v obrázku. Vyzkoušejte měnit pozici jezdců, v pra-
vém horním rohu dialogového okna zvolte možnost Preview on Image a pozorujte
změnu obrázku a změnu histogramu.
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Obr. 6.19: Dialogové okno Brightness/Contrast.

Obr. 6.20: Dialogové okno Levels.
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Křivky
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Souvislost Křivky a Úrovně, na stránce je na obrázku graficky znázorněna
souvislost mezi nástroji Křivky a Úrovně.

Vrstvu úprav Křivky vyvoláte v menu programu Layers > New Adjustment
Layer > Curves..., zobrazí se dialogové okno, viz obr. 6.21. Horizontální osa
u grafu znázorňuje vstupní hodnoty, vertikální osa znázorňuje výstupní hodnoty.
Body na křivku přidáte kliknutím na křivku. U jednotlivých bodů na křivce můžete
vedle grafu křivky u možností Input: a Output: nastavit hodnoty k přemapo-
vání vstupní hodnoty na výstupní. Nástroj Křivky je ve srovnání s nástroji Jas
a kontrast a Úrovně nejsložitější, umožňuje nelineární převodní charakteristiku. Vy-
zkoušejte měnit tvar křivky, v pravém horním rohu dialogového okna zvolte možnost
Preview on Image, pozorujte změnu obrázku a změnu histogramu.

Obr. 6.21: Dialogové okno Curves.

Stíny a světla
Nástroj Stíny a světla vyvoláte v menu programu Adjust > Brightness and
Contrast > Highlight/Midtone/Shadow..., zobrazí se dialogové okno, viz obr. 6.22.
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Vyzkoušejte měnit hodnotu u posuvníku Shadow:, v pravém horním rohu dialogo-
vého okna zvolte možnost Preview on Image, pozorujte změnu obrázku a změnu
histogramu [1].

Obr. 6.22: Dialogové okno Highlight/Midtone/Shadow.

6.2.3 Úkol – lokální a nedestruktivní úprava jasu v obrazu

V tomto úkolu se dozvíte, jak upravit jas části obrazu nedestruktivní úpravou.
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Úkol – lokální a nedestruktivní úprava jasu v obrazu. Po otevření
stránky uložte obrázek do počítače. Obrázek otevřete podle postupu uvedeného
v kapitole 6.2.1. Pro nedestruktivní úpravu vytvořte vrstvu obsahující 50% šedou
barvu, nastavte režim krytí na překrýt a aplikujte na ni nástroje Zesvětlit a Ztmavit.
Vyzkoušejte různé nastavení nástroje a ztmavte stromy v pozadí.

Vytvoření vrstvy s 50% šedou barvu
Vyberte 50% šedou barvu v dialogu Foreground and Stroke Properties v okně
Materials, viz obr. 6.23. Vytvoření nové vrstvy provedete v menu programu La-
yers > New Raster Layer... [4] nebo v levé dolní části programu, v menu
dialogového okna Layers, rozbalením nabídky New Layer a zvolením možnosti
New Raster Layer.... Zobrazí se dialogové okno New Raster Layer, u mož-
nosti Blend mode: zvolte Overlay a klikněte na tlačítko OK . V panelu nástrojů
vyberte 12. nástroj odshora, Flood Fill Toll, můžete použít klávesovou zkratku F
a klikněte do pracovní plochy. Vrstva se vyplní 50% šedou barvu, viz okno Layers.

Nástroje Zesvětlit a Ztmavit
Výběr nástrojů Zesvětlit a Ztmavit provedete v panelu nástrojů. Klikněte na šipku
u 10. nástroje odshora, vyberte nástroj Dodge pro zesvětlení a nástroj Burn pro
ztmavení. V dialogu Volby nástroje nastavte parametry nástroje, jako jsou např.
velikost, tvrdost, síla, rozsah tónů. Vyzkoušejte různé nastavení nástroje a ztmavte
stromy v pozadí.
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Obr. 6.23: Dialogové okno Material Properties.

6.2.4 Úkol – převod obrázku do palety

V tomto úkolu převeďte obrázek z RGB do barevné palety. V elearningu předmětu
v sekci Úpravy bitmapových obrazů klikněte na odkaz Úkol – převod obrázku
do palety. Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle
postupu uvedeného v kapitole 6.2.1.

Převod do barevné palety
Převedení obrázku do barevné palety provedete v menu programu Image > Decre-
ase Color Depth > 256 Color palette..., můžete zvolit i možnosti 2 Color
palette... a 16 Color palette... pro 2 a 16 barev v paletě, zobrazí se dialogové
okno, viz obr. 6.24. U možnosti Palette zvolte z několika možností barevných palet.
U možnosti Reduction method vyberte z několika možností rozptylování barev [5].
Po nastavení parametrů klikněte na tlačítko OK . Pro vrácení převodu použijte klá-
vesovou zkratku Ctrl + Z , vyzkoušejte různé nastavení převodu.

6.2.5 Úkol – uložení snímku obrazovky v paletovém režimu, vy-
nucené barvy

V tomto úkolu převeďte obrázek z RGB do barevné palety pomocí dialogu Export.
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na odkaz
Úkol – uložení snímku obrazovky v paletovém režimu, vynucené barvy.
Po otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu
uvedeného v kapitole 6.2.1. Obrázek převeďte z RGB do barevné palety pomocí dia-
logu Export. Při jakém počtu barev a při jakém algoritmu tvorby palety dosáhnete
nejlepších výsledků?
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Obr. 6.24: Dialogové okno pro nastavení převodu barev na indexované.

Export dialog
Barevnou paletu používají formáty PNG-8 a GIF. Otevření dialogového okna Ex-
port pro formát GIF provedete v menu programu File > Export > GIF Opti-
mizer..., pro formát PNG-8 v menu programu File > Export > PNG Opti-
mizer..., zobrazí se dialogové okno, viz obr. 6.25. V horní části dialogového okna
je náhledové okno s výsledným obrázkem po nastavení parametrů kompresního for-
mátu. Pod náhledovým oknem je u možností Uncompressed: a Compressed:
zobrazena velikost originálního a komprimovaného obrázku. Pod velikostmi souborů
můžete přepínat mezi okny. V okně Colors nastavte parametry formátu, zvolte
možnost Palette-Based a vyberte z několika možností barevných palet. U mož-
nosti How many Colors? nastavte počet barev v paletě, u možnosti How much
dithering? nastavte míru rozptylování [6]. Náhled výsledného obrázku je zobrazen
v náhledovém okně.

Po nastavení parametrů klikněte na tlačítko OK , zobrazí se dialogové okno s ad-
resářem souborů. V okně zvolte název souboru, umístění a klikněte na tlačítko Ulo-
žit.

6.2.6 Úkol – konvoluce obrázku s impulzní odezvou

V tomto úkolu aplikujte na obrázek několik lineárních filtrů – 2D Diracův impulz, po-
sunutý 2D Diracův impulz, dolní a horní propust. Vyzkoušejte různé varianty filtrů,
pozorujte změny obrázku. V elearningu předmětu v sekci Úpravy bitmapových
obrazů klikněte na odkaz Úkol – konvoluce obrázku s impulzní odezvou. Po
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Obr. 6.25: Dialogové okno Export for Web.

otevření stránky uložte obrázek s autem do počítače. Obrázek otevřete podle po-
stupu uvedeného v kapitole 6.2.1. Otevření dialogového okna Konvoluční matice
provedete v menu programu Effects > User Defined Filter... [7], zobrazí se
dialogové okno, viz obr. 6.26.

2D Diracův impuls
Jednotkový Diracův impuls neudělá žádnou změnu v obrázku. Pro aplikaci filtru
vyplňte hodnoty konvoluční matice, viz obr. 6.26.

Posunutý 2D Diracův impuls
Pro aplikaci posunutého 2D Diracova impulsu změňte hodnotu středního pole z 1 na 0.
V jednom libovolném poli, kromě pole ve středu matice změňte hodnotu z 0 na 1.
Pozorujte změnu obrázku zapnutím a vypnutím možnosti Preview on Image.

Dolní propust
Filtr dolní propust odpovídá rozmazání. Součet hodnot v matici musí být stejný
jako hodnota u možnosti Divisor:. Pro aplikaci filtru vyplňte hodnoty konvoluční
matice, viz obr. 6.27.
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Obr. 6.26: Konvoluční matice pro 2D Diracův impuls.

Obr. 6.27: Konvoluční matice pro dolní propust.
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Horní propust
Filtr horní propust odpovídá zaostření, součet hodnot v matici musí být roven 0.
Pro aplikaci filtru vyplňte hodnoty konvoluční matice, viz obr. 6.28.

Obr. 6.28: Konvoluční matice pro horní propust.

Vytlačení (emboss)
Pro aplikaci filtru vytlačení vyplňte hodnoty konvoluční matice, viz obr. 6.29.

6.2.7 Úkol – aplikace konvoluce při zostření snímku

V tomto úkolu doostřete obrázek buď pomocí filtru horní propust nebo filtru doost-
řit. V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Úkol – aplikace konvoluce při zostření snímku. Po otevření stránky uložte
obrázek do počítače. Obrázek otevřete podle postupu uvedeného v kapitole 6.2.1.

Doostření obrázku pomocí filtru horní propust
Duplikujte vrstvu obrázku v menu programu Layers > Duplicate nebo kliknutím
pravého tlačítka na vrstvu a zvolením možnosti Duplicate. Na nově vytvořenou
vrstvu aplikujte filtr horní propust v menu programu Effects > Edge Effects >
High Pass... [8], zobrazí se dialogové okno, viz obr. 6.30. V okně vyzkoušejte různé
nastavení parametrů. Po nastavení parametrů klikněte na tlačítko OK .
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Obr. 6.29: Konvoluční matice pro filtr vytlačení.

Obr. 6.30: Dialogové okno filtru High Pass.

Změnu režimu prolnutí vrstvy na překrýt provedete rozbalením nabídky nad
vrstvou a zvolením možnosti Overlay nebo kliknutím pravého tlačítka na vrstvu
a zvolením možnosti Properties..., otevře se dialogové okno, ve kterém u možnosti
Blend mode: zvolte Overlay.

Doostření obrázku pomocí filtru doostřit (Unsharp Mask)

Na obrázek aplikujte filtr doostřit v menu programu Adjust > Sharpness >
Unsharp Mask... [8], zobrazí se dialogové okno, viz obr. 6.31. V okně vyzkoušejte
různé nastavení parametrů. Po nastavení parametrů klikněte na tlačítko OK .
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Obr. 6.31: Dialogové okno filtru Unsharp Mask.

6.2.8 Úkol – rozdíl mezi změnou velikosti a změnou rozlišení

V tomto úkolu pochopíte rozdíl mezi změnou rozlišení a změnou velikosti obrázku.
V elearningu předmětu v sekci Úpravy bitmapových obrazů klikněte na od-
kaz Úkol – rozdíl mezi změnou velikosti a změnou rozlišení. Po otevření
stránky uložte obrázek do počítače. Obrázek otevřete podle postupu uvedeného
v kapitole 6.2.1. Změňte rozlišení obrázku na 300 ppi. Jaké velikosti obrázku v tisku
to odpovídá? Změňte velikost obrázku (proporcionálně) tak, aby jeho šířka byla
600 px. Jak velký bude obrázek na monitoru?

Změna rozlišení obrázku
Změnu rozlišení obrázku provedete v menu programu Image > Resize... nebo klá-
vesovou zkratkou Shift + S, zobrazí se dialogové okno, v horní části okna zvolte By
Print Size, viz obr. 6.32. U možnosti Resolution: zvolte hodnotu 300 Pixels/Inch
a u možnosti Resample using: zvolte Bicubic. Pro zjištění velikosti obrázku
v tisku zvolte u možnosti Width: jednotku Centimeters a odečtěte hodnoty [4].
Po nastavení parametrů klikněte na tlačítko OK .

Změna velikosti obrázku
Změnu velikosti obrázku provedete v menu programu Image > Resize... nebo
klávesovou zkratkou Shift + S, zobrazí se dialogové okno, viz obr. 6.32. V horní
části okna zvolte By Pixels, u možnosti Width: zvolte hodnotu 600 . Pro zjištění
velikosti obrázku zvolte v horní části okna By Print Size, u možnosti Width:
zvolte jednotku Centimeters a odečtěte hodnoty. Po nastavení parametrů klikněte
na tlačítko OK .

6.2.9 Úkol – volba interpolačního jádra při převzorkování

V tomto úkolu zmenšete obrázek, vyzkoušejte různé interpolační jádra a pozorujte
rozdíly v obrázku. V elearningu předmětu v sekci Úpravy bitmapových obrazů
klikněte na odkaz Úkol – volba interpolačního jádra při převzorkování. Po
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Obr. 6.32: Dialogové okno pro změnu rozlišení a velikosti.

otevření stránky uložte obrázek do počítače. Obrázek otevřete podle postupu uve-
deného v kapitole 6.2.1. Obrázek zmenšete na 25 % původní velikosti a vyzkoušejte
různé volby interpolačního jádra. Která z nich dává nejpřijatelnější výsledky? Jaký
jev pozorujete u všech ostatních?

Převzorkování obrázku
Změnu velikosti obrázku a volbu interpolačního jádra provedete v menu programu
Image > Resize... nebo klávesovou zkratkou Shift + S, zobrazí se dialogové
okno, viz obr. 6.32. V horní části okna zvolte By Percentage, u možnosti Per-
cent zvolte hodnotu 25 a u možnosti Resample using: volte z nabízených mož-
ností. Možnost Weighted Average nejspíše odpovídá metodě nejbližší soused [1],
možnost Bilinear odpovídá metodě bilineární, možnost Bicubic odpovídá metodě
bikubická. Po nastavení parametrů klikněte na tlačítko OK .

6.2.10 Kontrolní otázky

1. Co je to histogram?
2. Co způsobí filtr typu dolní propust?
3. Jaký je rozdíl mezi změnou velikosti a změnou rozlišení obrazu?
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Závěr
Cílem této práce bylo seznámit se s obsahem výuky v předmětu Základy počítačové
sazby a grafiky a inovovat cvičení, ve kterých se nyní používá program Adobe Photo-
shop CS6 Extended. Inovace cvičení spočívala v připravení návodů v alternativních
programech pro zpracování obrazu.

V první kapitole byla rozebrána teorie zabývající se bitmapovou grafikou, jsou
zde popsány barevné modely, barevné prostory, správa barev a formáty bitmapové
grafiky. V druhé kapitole byly představeny bitmapové editory, bylo provedeno jejich
porovnání na základě několika kritérií. Byla zvážena cenová náročnost pro školu i pro
studenta. Následně byl proveden výběr programů vhodných pro výuku zpracování
obrazu.

Zoner Photo Studio X má méně přívětivé uživatelské prostředí, než ostatní pro-
gramy. Nepodporuje např. barevný prostor LAB, kanály, barevný režim indexovaná
barva, uložení souboru do formátu JPEG 2000, šedé kapátko u úrovní.

Affinity Photo má přivětivé uživatelské prostředí, podobné Adobe Photoshop.
Nepodporuje např. uložení bitmapy do formátu BMP, JPEG 2000, filtr typu konvo-
luční matice, šedé kapátko u úrovní.

Adobe Photoshop CC 2021 z pohledu využití ve výuce zpracování obrazu nepři-
náší velké výhody, funkce používané ve výuce podporuje i starší verze programu.
Finanční náročnost verze CC 2021 je pro školu výrazně vyšší v porovnání se starší
verzí CS6.

Corel PaintShop Pro 2022 má přívětivé, intuitivní prostředí, podobné Adobe
Photoshop. Cena programu je 39,99 $ za jednu trvalou licenci. Nepodporuje např.
kontrolu gamutu, náhled tiskového výstupu, barevný prostor LAB, kanály. Podpo-
ruje vrstvy úprav, exportní formáty používané ve třetím cvičení a funkce používané
ve čtvrtém cvičení.

GIMP je bezplatný, podporuje všechny operační systémy, má přehledné uživatel-
ské prostředí, možnost rozšíření pluginy. Nevýhodou programu je nemožnost vrstev
úprav, tato funkcionalita však může být v následujících letech vývojáři přidána.

Pro výuku zpracování obrazu, jako alternativu k programu Photoshopu CS6
Extended byly vybrány programy GIMP a Corel PaintShop Pro 2022. V dalších
kapitolách byly vypracovány návody pro jednotlivá počítačová cvičení ve vybraných
programech. Návody pro program Corel PaintShop Pro 2022 byly vypracovány ve
zkušební verzi programu.

Program Corel PaintShop Pro 2022 je nevhodný pro první počítačové cvičení,
má omezené možnosti nastavení správy barev, neumožňuje náhled kontroly gamutu
a náhled tiskového výstupu. V rámci ostatních cvičení může být použit jako alter-
nativa k programu Adobe Photoshop CS6 Extended.
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Program GIMP bohužel nepodporuje vrstvy úprav. Program byl rozšířen v rámci
třetího počítačového cvičení pluginy pro JPEG 2000 a Export for Web. V rámci vý-
uky může být použit jako alternativa k programu Adobe Photoshop CS6 Extended.

Pro výuku zpracování obrazu doporučuji jako alternativní program k programu
Adobe Photoshop CS6 Extended program GIMP z důvodu podporovaných ope-
račních systémů, funkcí, možnosti rozšíření pluginy. V budoucnu mohou absolventi
předmětu Základy počítačové sazby a grafiky použít tento program zdarma pro
zpracování obrazu nebo vytvoření bitmapové grafiky.
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Seznam symbolů a zkratek
2D Dvoudimenzionální prostor

Alt Alternate

AMD Advanced Micro Devices

API Application Programming Interface

BMP Bitmap

bpp Bits per pixel

BSD Berkeley Software Distribution

CC Creative Cloud

CMY Cyan Magenta Yellow

CMYK Cyan Magenta Yellow Key

CS6 Creative Suite 6

Ctrl Control

DCT Discrete Cosine Transform

DPH Daň z přidané hodnoty

GB Gigabyte

GHz Gigahertz

GIF Graphics Interchange Format

GIMP GNU Image Manipulation Program

GNU GNU’s Not Unix

HDD Hard Disk Drive

HEIF High Efficiency Image Format

HSB Hue Saturation Brightness

HSL Hue Saturation Lightness

HSV Hue Saturation Value
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HW Hardware

ICC International Color Consortium

in Inch

JPEG Joint Photographic Experts Group

Kč Koruna česká

LZW Lempel-Ziv-Welch

LZ77 Lempel-Ziv 77

MB Megabyte

mm Milimetr

OS Operační systém

PNG Portable Network Graphics

ppi Pixels per inch

PSD Photoshop Document

PSP Paint Shop Pro

px Pixel

RAM Random Access Memory

RGB Red Green Blue

RGBA Red Green Blue Alpha

RLE Run-Length Encoding

ROI Region of interest

sRGB standard RGB

TIFF Tagged Image File Format

URL Uniform Resource Locator

XCF eXperimental Computing Facility

ZPS Zoner Photo Studio
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